

    
      
          
            
  
Welcome to Read the Docs

This is an autogenerated index file.

Please create an index.rst or README.rst file with your own content
under the root (or /docs) directory in your repository.

If you want to use another markup, choose a different builder in your settings.
Check out our Getting Started Guide [https://docs.readthedocs.io/en/latest/getting_started.html] to become more
familiar with Read the Docs.
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IIC

I2C总线（I2C bus，Inter-IC bus）是一个双向的两线连续总线，提供集成电路（ICs）之间的通信线路。




CAN

CAN 全称为 ControllerArea Network，即控制器局域网，是国际上应用最广泛的现场 总线之一。最
初 CAN 总线被设计作为汽车环境中的微控制器通讯，在车载各电子控制装置 ECU 之间交换信息，形
成汽车电子控制网络。比如，发动机管理系统、变速箱控制器、仪表装备、电子主干系统中均嵌入 CAN
控制装置。




EEPROM

EEPROM，或写作E2PROM，全称电子抹除式可复写只读内存 （英语：Electrically-Erasable Programmable Read-Only Memory），是一种可以通过电子方式多次复写的半导体存储设备。相比EPROM，EEPROM不需要用紫外线照射，也不需取下，就可以用特定的电压，来抹除芯片上的信息，以便写入新的数据。




总线驱动

总线驱动：在linux驱动架构中，几乎不需要驱动开发人员再添加bus，因为linux内核几乎集成所有总线bus，如usb、pci、i2c等等，并且总线bus中的（与特定硬件相关的代码）已由芯片提供商编写完成。例如TI davinci平台i2c总线bus与硬件相关的代码在
内核目录/drivers/i2c/buses下的i2c-davinci.c源文件中；而三星的s3c-2440平台i2c总线bus为/drivers/i2c/buses/i2c-s3c2410.c。




设备驱动

设备驱动：与特定设备相关的就需要驱动工程师来实现了。
与总线驱动关系：如拿i2c来说，linux内核和芯片提供商已经为我们的驱动程序提供了i2c驱动的框架，以及框架底层与硬件相关的代码的实现。一般情况下，对驱动开发人员来讲，剩下的就是针对挂载在i2c两线上的i2c设备，编写具体的设备驱动了，这里的设备是指soc外部挂载的设备，并不包含集成在soc内部的设备，如i2c控制器，反而集成在soc内部设备的驱动可以理解为总线驱动。




JNI与NDK的区别

JNI是Java调用Native机制，是Java语言自己的特性全称为 Java Native Interface，类似的还有微软.Net Framework上的p/invoke，可以让C#或Visual Basic.NET调用C/C++的API，所以说JNI和Android没有关系，在PC上开发Java的应用，如果运行在Windows平台使用 JNI是是经常的，比如说读写Windows的注册表。
NDK是Google公司推出的帮助Android开发者通过C/C++本地语言编写应用的开发包，包含了C/C++的头文件、库文件、说明文档和示例代码，我们可以理解为Windows Platform SDK一样，是纯C/C++编写的，但是Android并不支持纯C/C++编写的应用，同时NDK提供的库和函数功能很有限，仅仅处理些算法效率敏感的问题。
NDK其实多了一个把.so和.apk打包的工具，这个是很重要的。
而JNI开发并没有打包，只是把.so文件放到文件系统的特定位置。




<<<<<<< 7b647ecd48083c061990cc45d99435d8d21646a7
##POSIX
POSIX是Portable Operating System Interface foIX的首字母缩写词，是一套 IEEE 和ISO标准。这个标准定义了应用程序和操作系统之间的一个口。只要保证他们的程序设计的符合 POSIX 标准，开发人员就能确信他们的程序可以和支持SIX 的操作系统互联。这样的操作系统包括大部分版本的 UNIX。POSIX 标准现在由 IEEE 的一分支机构Portable Applications Standards Committee(PASC)维护。


POSIX

POSIX是Portable Operating System Interface foIX的首字母缩写词，是一套 IEEE 和ISO标准。这个标准定义了应用程序和操作系统之间的一个口。只要保证他们的程序设计的符合 POSIX 标准，开发人员就能确信他们的程序可以和支持SIX 的操作系统互联。这样的操作系统包括大部分版本的 UNIX。POSIX 标准现在由 IEEE 的一分支机构Portable Applications Standards Committee(PASC)维护。

##共阴极数码
共阴极数码管是指将所有发光二极管的阴极接到一起形成公共阴极(COM)的数码管，共阴数码管在应用时应将公共极COM接到地线GND上，当某一字段发光二极管的阳极为高电平时，相应字段就点亮，当某一字段的阳极为低电平时，相应字段就不亮。








Updates book.json
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第一章.  开发平台简介





          

      

      

    

  

    
      
          
            
  
平台硬件资源




	**ARM处理器
（标配）
**





   处理器Samsung EXYNOS4412，四核心处理器，基于ARM Quad Cortex-A9，运行主频1.5GHz
   内置Mali-400 MP高性能图形引擎
   支持流畅的2D/3D图形加速
最高可支持1080p@30fps硬件解码视频流畅播放，格式可为MPEG4，H.263，H.264等
   最高可支持1080p@30fps硬件解码（Mpeg-2/VC1）视频输入
   RAM内存：1G DDR3；32bit数据总线；运行频率: 400MHz
   FLASH：8GB eMMC闪存
  
    
    产品概述
    

    
 
  

    
      
          
            
  
产品概述



[image: ../_images/product.png]

图1 CBT-EMB-MIP开发平台

多核心嵌入式技术教学创新平台，是北京赛佰特科技有限公司针对全国高校和职业类院校嵌入式系统相关实验室建设精心设计推出的综合实验平台。该平台采用ARM处理器+ARM微控制器多核心方式设计，配备多种传感器模块和常用接口，不仅可以学习各种核心处理器，还可以学习多种传感器模块及控制总线，能够满足不同层次的学习需求，更能够让学生由浅至深的全面了解嵌入式系统，同时提供丰富的实验例程和文档资料，以及全面的技术支持，可以完全满足高校嵌入式教学的相关需求和实验室建设方案。

平台主要有ARM处理器、ARM微控制器和底板三部分构成，ARM处理器标配以Cortex-A9为核心（可选配Cortex-A8核心），可流畅运行Linux、Android操作系统；ARM微控制器标配为Cortex-M4核心板，可选配接口兼容：Cortex-M3核心板、Cortex-M0核心板、MSP430单片机核心板等。底板涵盖以下嵌入式系统常见接口：RS485、SPI、I2C、CAN总线，USART、USB、PCIE通讯接口，调试接口，网络接口；板载多种传感器：光敏传感器、温湿度传感器、三轴加速度传感器、红外接收、FM收音机，丰富数据处理功能和应用；板载3个扩展模块接口，可选配GPRS模块，GPS模块，RFID模块，扩展性强，支持多种产品配套的扩展模块：ZigBee模块、IPv6模块、WIFI模块、Bluetooth模块以及10几种传感器模块，同时配备完善的实验指导书及配套教材、配套培训服务。

Cortex-A9核心板同Cortex-M4核心板共享外围传感器电路，可通过底板上CPLD一键切换对外围传感器电路进行连接控制。共享的外围电路为：RS485，3路引出的USART接口，红外接收，直流、步进电机，电位器，光敏电阻，PWM蜂鸣器，SHT11温湿度传感器，三轴加速，EEPROM，数码管，LED，收音机，SPI接口，I2C接口。
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产品特点



	多核心嵌入式技术教学创新平台采用多核心设计，平台同时配备ARM核心处理器和ARM微控制器，核心处理器采用Cortex-A9内核，微控制器采用Cortex-M4内核，能够让学生由浅至深的学习嵌入式系统，同时可选配Cortex-A8、Cortex-M3、Cortex-M0、MSP430等核心，可满足不同层次的教学需求；

	ARM核心处理器和ARM微控制器共享外围传感器电路，可通过底板上CPLD一键切换对外围传感器电路的连接控制，共享的外围电路为：RS485，红外接收，直流、步进电机，电位器，光敏电阻，PWM蜂鸣器，SHT11温湿度传感器，三轴加速，EEPROM，数码管，LED，收音机，SPI接口，I2C接口，可完成不同核心处理器的多种教学实验；

	本教学创新平台配备10寸超大高清可视触摸屏，支持1080P/720P/480P，可支持各种显示实验，通过超大触屏人机交互，增加用户体验，丰富实验及应用设计内容；

	平台板载可编程CPLD芯片，结合丰富的外设和实验例程，可对Verilog和VHDL硬件描述语言及程序设计进行深入学习和研究；

	平台板载3个扩展通讯模块接口，支持ZigBee模块、IPv6模块、WIFI模块、Bluetooth模块、GPRS模块，BD2/GPS卫星定位模块，RFID模块以及10几种传感器模块，扩展性强。
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平台软件资源




 
  	操作系统OS
  	Linux2.6.35\Linux3.0.5\Linux3.5\Android4.0\Android4.2\uCOS
 

 
  	Bootloader
  	U-Boot
 

 
  	文件系统
  	YAFFS2\CRAMFS\FAT32\EXT4
 

 
  	图形UI
  	Qt4/Embedded、Qtopia4\Android Studio
 

 
  	程序设计
  	可进行单片机、uCOS、Linux、 Android 嵌入式系统编程开发，包括开发环境搭建、Bootloader开发、嵌入式操作系统移植、驱动程序调试与开发、应用程序的移植与开发，综合应用项目案例软件开发与设计等
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第二章.  Android开发环境搭建
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实验一. Android SDK Windows系统环境搭建




实验目的


	掌握在Windows下，Android集成开发环境的搭建;


	熟悉集成开发环境;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机;


	软件： Android Studio ,JDK;







实验内容


	搭建 Android 集成开发环境;


	创建 Android 模拟器AVD;




Android国内官方网址：https://developer.android.google.cn




实验步骤

本地安装包路径：光盘\tools\Android Windows环境搭建\。

└─Android Windows环境搭建
        android-studio-bundle-145.3537739-windows.exe //包含 Android SDK
        jdk-8u102-windows-i586.exe  //32位
        jdk-8u102-windows-x64.exe  //64位
        studio-install-windows.mp4 //安装视频
        usb_driver.rar //adb驱动






Java开发环境安装


	启动jdk-*.exe，根据安装向导指示安装。


	配置环境变量。选择**“Start”菜单 > 电脑 > 属性 > 高级系统选项**。然后打开**“高级”选项卡 > 环境变量**进行配置。


	在“系统变量”新建一个变量名为JAVA_HOME的变量，变量值为你本地java的安装目录，这里为：C:\Program Files\Java\jdk1.8.0_31，设置这个的目的是作为下面两个环境变量的一个引用


	在“系统变量”选项区域中查看PATH变量，如果不存在，则新建变量PATH，否则选中该变量，单击“编辑”按钮，在“变量值”文本框的起始位置添加“%JAVA_HOME%\bin;%JAVA_HOME%\jre\bin;”


	在“系统变量”选项区域中查看CLASSPATH变量，如果不存在，则新建变量CLASSPATH，否则选中该变量，单击“编辑”按钮，在“变量值”文本框的起始位置添加“.;%JAVA_HOME%\lib\dt.jar;%JAVA_HOME%\lib\tools.jar;”。
判断是否安装成功：
在cmd命令行中输入命令：
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实验二. Android ADB调试实验


实验目的


	掌握在Windows下，Android ADB 环境的搭建


	了解Android SDK的开发环境


	熟悉Android 应用程序的安装, 文件的传输







实验设备


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio;







实验内容


	搭建Android ADB 环境，安装MiniUSB驱动，通过adb 访问android平台上的文件系统


	通过adb安装Android 应用程序


	通过adb传输文件







实验步骤


驱动安装


	打开Android平台设备，插入MiniUSB线与PC相连。


	右击“我的电脑”->“属性”-> “硬件” ，打开“设备管理器”，如图4.1.1所示




[image: ../../_images/device_manager.png]

图4.1.1 设备管理器


	右键“S5P
OTG-USB”，选择安装驱动，选择“从列表或指定位置安装（高级）”，如图4.1.2所示，点击“下一步”




[image: ../../_images/driver_wizard.png]

图4.1.2 安装ADB驱动


	点击“浏览”，在Android SDK
安装路径中选择USB驱动程序的路径，这里选择“D:\\Android\\android-sdk-windows\\extras\\google\\usb\_driver”(以用户实际SDK安装解压路径为准),选择路径后点击“下一步”进行安装，如图4.1.3所示




[image: ../../_images/chose_path.png]

图4.1.3 安装ADB驱动


	点击“完成”，如图4.1.4所示




[image: ../../_images/setup_complete.png]

图4.1.4 安装ADB驱动


	再次打开设备管理器，如图4.1.5所示，“Android Composite ADB
Interface”驱动安装成功




[image: ../../_images/adb_interface.png]

图4.1.5 安装ADB驱动




ADB环境配置及测试


	将ADB命令所在的路径添加到Path环境变量中


	右击“我的电脑”->“属性” ，再选择“高级系统设置”选项。


	点击“环境变量”选项。


	在“系统变量”中，找到Path环境变量，双击它，在变量值前面追加一下内容：“D:\Android\android-sdk-windows\platform-tools；”(以用户实际SDK安装解压路径为准)，注意后面有一个分号，如图4.2.1所示








[image: ../../_images/adb_env.png]

图4.2.1 配置ADB环境变量


	
	点击“确定”完成环境变量设置。


	在cmd.exe上按回车来启动DOS窗口，输入adb按回车，显示如图4.2.2所示则表明环境变量设置OK。








[image: ../../_images/adb_cmd.png]

图4.2.2 命令行


	输入以下命令，查看设备连接状态（开发板已经用miniUSB和PC连接）




$ adb devices





若显示如下信息所示则表示成功连接到Android平台设备。

List of devices attached
* daemon not running. starting it now on port 5037 *
* daemon started successfully *
SuperIOT4Android        device








ADB安装软件


	在Windows目录下新建一个文件夹（D:\hello），把Android光盘\src\chapter02\experiment02\hello.apk复制到D：\hello目录下


	以安装D:\hello\hello.apk的程序为例，在DOS窗口输入以下命令进行安装




> adb install D: \\hello\\hello.apk






	DOS窗口如图4.3.1所示




[image: ../../_images/adb_install.png]

图4.3.1 命令行安装


	查看Android 平台，找到“hello”应用程序，如图4.3.2所示




[image: ../../_images/adb_hello.png]

图4.3.2 hello程序




ADB传输文件


	确保A9网关已启动且用miniUSB线与PC端连接


	打开光盘tools目录下的串口终端putty，进入Android系统根目录，输入“su”命令获取root权限。


	将根目录挂载成读写权限，输入如下命令：




# mount -o remount rw, /






	新建文件夹source




# mkdir source






	以上传D:\hello\hello.apk的程序为例，在DOS窗口输入以下命令进行传输




\> adb push D: \\hello\\hello.apk source






	文件上传成功，即可以在Android系统文件夹目录下看到下载的文件DOS窗口如图4.4.1所示




[image: ../../_images/adb_push_file.png]

图4.4.1 ADB传输文件

关于ADB更详细使用请查阅官方文档：https://developer.android.google.cn/studio/command-line/adb.html









          

      

      

    

  

  
    
    Test
    

    
 
  

    
      
          
            
  
Test





          

      

      

    

  

  
    
    <no title>
    

    
 
  

    
      
          
            
  的考试jfk了多少积分



          

      

      

    

  

  
    
    实验一. Intent 组件间通讯实验
    

    
 
  

    
      
          
            
  
实验一. Intent 组件间通讯实验





          

      

      

    

  

  
    
    实验二. Android的数据存储和IO——简单存储
    

    
 
  

    
      
          
            
  
实验二. Android的数据存储和IO——简单存储





          

      

      

    

  

  
    
    实验三. 图形图像处理——在Android中访问图片
    

    
 
  

    
      
          
            
  
实验三. 图形图像处理——在Android中访问图片





          

      

      

    

  

  
    
    第五章. Android NDK开发实验
    

    
 
  

    
      
          
            
  
第五章.  Android NDK开发实验





          

      

      

    

  

  
    
    实验一. Android NDK之Hello World开发入门实验
    

    
 
  

    
      
          
            
  
实验一. Android NDK之Hello World开发入门实验




术语解释


NDK


NDK（英语：native development kit，简称NDK）是一种基于原生程序接口的软件开发工具。通过此工具开发的程序直接以本地语言运行，而非虚拟机。因此只有java等基于虚拟机运行的语言的程序才会有原生开发工具包。





	NDK是一系列工具的集合





NDK提供了一系列的工具，帮助开发者快速开发C（或C++）的动态库，并能自动将so和java应用一起打包成apk。这些工具对开发者的帮助是巨大的。





	NDK集成了交叉编译器，并提供了相应的mk文件隔离CPU、平台、ABI等差异，开发人员只需要简单修改mk文件（指出“哪些文件需要编译”、“编译特性要求”等），就可以创建出so。





NDK可以自动地将so和Java应用一起打包，极大地减轻了开发人员的打包工作。





	那我们为什么要使用呢?


	代码的保护。由于apk的java层代码很容易被反编译，而C/C++库反汇难度较大。


	可以方便地使用现存的开源库。大部分现存的开源库都是用C/C++代码编写的。


	提高程序的执行效率。将要求高性能的应用逻辑使用C开发，从而提高应用程序的执行效率。


	便于移植。用C/C++写得库可以方便在其他的嵌入式平台上再次使用。








  NDK提供了一份稳定、功能有限的 API 头文件声明Google 明确声明该API是稳定的，在后续所有版本中都稳定支持当前发布的API。从该版本的NDK中看出，这些API支持的功能非常有限，包含有：C 标准库（libc）、标准数学库（libm）、压缩库（libz）、Log 库（liblog）。




JNI


JNI（Java NativenInterface）是java与C/C++进行通信的一种技术，使用JNI技术，可以java调用C/C++的函数对象等等，Android中的Framework层与Native层就是采用的JNI技术。




  我们知道，Android系统是基于linux开发，采用的是linux内核 ，Android APP开发大部分也要和系统打交道，只是Android FrameWork 帮我们处理了和系统相关的操作， 我们从Android 系统的分成结构可以看出，Android FrameWork是通过JNI与底层的C/C++库交互，例如：FreeType，OpenGL，SQLite，音视频等等。

[image: ../../_images/1240.png]Android系统框图

如果我们程序也需要调用自己的C/C++函数库，就必须用到JNI/NDK开发。




Cmake


CMake 是个开源的跨平台自动化建构系统，它用配置文件控制建构过程（build process）的方式和Unix的Make相似，只是CMake的配置文件取名为CMakeLists.txt。Cmake并不直接建构出最终的软件，而是产生标准的建构档（如Unix的Makefile或Windows Visual C++的projects/workspaces），然后再依一般的建构方式使用。这使得熟悉某个集成开发环境（IDE）的开发者可以用标准的方式建构他的软件，这种可以使用各平台的原生建构系统的能力是CMake和SCons等其他类似系统的区别之处。CMake可以编译源代码、制做程序库、产生适配器（wrapper）、还可以用任意的顺序建构可执行文件。CMake支持in-place建构（二进档和源代码在同一个目录树中）和out-of-place建构（二进档在别的目录里），因此可以很容易从同一个源代码目录树中建构出多个二进档。CMake也支持静态与动态程序库的建构。“CMake”这个名字是”cross platform make”的缩写。虽然名字中含有”make”，但是CMake和Unix上常见的“make”系统是分开的，而且更为高级。





	Cmake的优势


	可以直接的在C/C++代码中加入断点，进行调试


	java引用的C/C++中的方法，可以直接ctrl+左键进入


	对于include的头文件，或者库，也可以直接的进入


	不需要配置命令行操作,手动的生成头文件,不需要配置android.useDeprecatedNdk=true 属性使用 Android studio，你可以将 C 和 C++ 代码编译成 native library（即 .so文件），然后打包到你的 APK 中。你的 Java 代码可以通过 Java Native Interface（JNI）调用 native library 中的方法。








  Android Studio 用于构建原生库的默认工具是
CMake。由于很多现有项目都使用构建工具包编译其原生代码，Android Studio
还支持
ndk-build [https://developer.android.com/ndk/guides/ndk-build.html]。如果您想要将现有的ndk-build 库导入到您的 Android Studio 项目中，请参阅介绍如何配置 Gradle以关联到您的原生库的部分。不过，如果您在创建新的原生库，则应使用CMake。

  本页面介绍的信息可以帮助您使用所需构建工具设置 Android
Studio、创建或配置项目以支持 Android 上的原生代码，以及构建和运行应用。


注：要在 Android Studio 中使用 CMake 或者 ndk-build，你需要使用Android Studio 2.2 或更高的版本，同时需要配合使用 Android Plugin for Gradle 2.2.0 及以上的版本。









下载 NDK 和构建工具

要为您的应用编译和调试原生代码，您需要以下组件：


	Android 原生开发工具包
(NDK) [https://developer.android.com/ndk/index.html]：这套工具集允许您为
Android 使用 C 和 C++ 代码，并提供众多平台库，让您可以管理原生
Activity 和访问物理设备组件，例如传感器和触摸输入。


	CMake [https://cmake.org/]：一款外部构建工具，可与 Gradle
搭配使用来构建原生库。如果您只计划使用 ndk-build，则不需要此组件。


	LLDB [http://lldb.llvm.org/]：一种调试程序，Android Studio
使用它来调试原生代码 [https://developer.android.com/studio/debug/index.html]。




您可以使用 SDK
管理器 [https://developer.android.com/studio/intro/update.html#sdk-manager]安装这些组件：


	在打开的项目中，从菜单栏选择 Tools > Android > SDK Manager。


	点击 SDK Tools 标签。


	选中 LLDB、CMake 和 NDK 旁的复选框，如图 1
所示。[image: ../../_images/Figure-1.png]Figure-1.png-34.8kB

**图 1.**从 SDK 管理器中安装 LLDB、CMake 和 NDK。



	点击 Apply，然后在弹出式对话框中点击 OK。


	安装完成后，点击 Finish，然后点击 OK。







创建支持 C/C++ 的新项目

创建支持原生代码的项目与创建任何其他 Android Studio
项目 [https://developer.android.com/studio/projects/create-project.html]类似，不过前者还需要额外几个步骤：


	在向导的 Configure your new project 部分，选中 Include C++
Support 复选框。


	点击 Next。


	正常填写所有其他字段并完成向导接下来的几个部分。


	在向导的 Customize C++ Support
部分，您可以使用下列选项自定义项目：


	C++ Standard：使用下拉列表选择您希望使用哪种 C++ 标准。选择
Toolchain Default 会使用默认的 CMake 设置。


	Exceptions Support：如果您希望启用对 C++
异常处理的支持，请选中此复选框。如果启用此复选框，Android Studio
会将 -fexceptions 标志添加到模块级 build.gradle 文件的
cppFlags 中，Gradle 会将其传递到 CMake。


	Runtime Type Information Support：如果您希望支持
RTTI，请选中此复选框。如果启用此复选框，Android Studio 会将
-frtti 标志添加到模块级 build.gradle 文件的 cppFlags
中，Gradle 会将其传递到 CMake。






	点击 Finish。




在 Android Studio 完成新项目的创建后，请从 IDE 左侧打开 Project
窗格并选择 Android 视图。如图 2 中所示，Android Studio 将添加
cpp 和 External Build Files 组：
[image: ../../_images/Figure-2.png]Figure-2.png-41.4kB

**图 2.**您的原生源文件和外部构建脚本的 Android 视图组。


	在 cpp组中，您可以找到属于项目的所有原生源文件、标头和预构建库。对于新项目，Android
Studio 会创建一个示例 C++ 源文件native-lib.cpp，并将其置于应用模块的 src/main/cpp/目录中。本示例代码提供了一个简单的C++函数stringFromJNI()，此函数可以返回字符串“Hello from C++”。要了解如何向项目添加其他源文件，请参阅介绍如何创建新的原生源文件的部分。


	在 External Build Files 组中，您可以找到 CMake 或 ndk-build
的构建脚本。与 build.gradle 文件指示 Gradle
如何构建应用一样，CMake 和 ndk-build
需要一个构建脚本来了解如何构建您的原生库。对于新项目，Android Studio
会创建一个 CMake 构建脚本CMakeLists.txt，并将其置于模块的根目录中。要详细了解此构建脚本的内容，请参阅介绍如何创建
Cmake 构建脚本的部分。





手动添加native方法

上面主要介绍程序自动生成的代码，接下来自己动手写。
我们也可以在MainActivity中写一个native方法。

    /**
     * A native method that is implemented by the 'native-lib' native library,
     * which is packaged with this application.
     */
    public native String stringFromJNI();
    //手动添加native方法
    public native String stringFromJNI2();





新方法stringFromJNI2()有红色警告，将光标定位到该函数并按下alt+Enter键。会弹出如图3所示的下拉列表，选择Create function ...选项[image: ../../_images/manual_add_native_method.png]创建native方法

**图 3.**创建本地方法。跳转到native-lib.cpp会自动生成对应的底层方法。

  JNIEXPORT jstring JNICALL
Java_cbt_edu_iot_ndksample_MainActivity_stringFromJNI2(JNIEnv *env, jobject instance) {

    // TODO


    return env->NewStringUTF(returnValue);
}





参考之前的方法将错误修复。

extern "C"
JNIEXPORT jstring JNICALL
Java_cbt_edu_iot_ndksample_MainActivity_stringFromJNI2(JNIEnv *env, jobject instance) {
    std::string hello = "Hello from C++ 2";
    return env->NewStringUTF(hello.c_str());
}





修改MainActivity代码，调用新添加的native方法stringFromJNI2()。

//        tv.setText(stringFromJNI());
        tv.setText(stringFromJNI2());








构建和运行示例应用 

点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
后，Android Studio 将在您的 Android
设备或者模拟器上构建并启动一个显示文字“Hello from
C++ 2”的应用。下面的概览介绍了构建和运行示例应用时会发生的事件：


	Gradle 调用您的外部构建脚本 CMakeLists.txt。


	CMake 按照构建脚本中的命令将 C++ 源文件 native-lib.cpp
编译到共享的对象库中，并命名为 libnative-lib.so，Gradle
随后会将其封装到 APK 中。


	运行时，应用的 MainActivity 会使用
System.loadLibrary() [https://developer.android.com/reference/java/lang/System.html#loadLibrary(java.lang.String)]
加载原生库。现在，应用可以使用库的原生函数 stringFromJNI()。


	MainActivity.onCreate() 调用 stringFromJNI()，这将返回“Hello
from C++”并使用这些文字更新
TextView [https://developer.android.com/reference/android/widget/TextView.html]。




注：Instant
Run [https://developer.android.com/studio/run/index.html#instant-run]
与使用原生代码的项目不兼容。Android Studio 会自动停用此功能。

如果您想要验证 Gradle 是否已将原生库封装到 APK 中，可以使用 APK
分析器 [https://developer.android.com/studio/build/apk-analyzer.html]：


	选择 Build > Analyze APK。


	从 app/build/outputs/apk/ 目录中选择 APK 并点击 OK。


	如图 3 中所示，您会在 APK 分析器窗口的 lib/<ABI>/ 下看到
libnative-lib.so。[image: ../../_images/Figer-3.png]Figer-3.png-58.5kB

**图 3.**使用 APK 分析器定位原生库。





提示：如果您想要试验使用原生代码的其他 Android 应用，请点击 File
> New > Import Sample 并从 Ndk 列表中选择示例项目。






向现有项目添加 C/C++ 代码

如果您希望向现有项目添加原生代码，请执行以下步骤：


	创建新的原生源文件并将其添加到您的 Android Studio
项目中。


	如果您已经拥有原生代码或想要导入预构建的原生库，则可以跳过此步骤。






	创建 CMake
构建脚本，将您的原生源代码构建到库中。如果导入和关联预构建库或平台库，您也需要此构建脚本。


	如果您的现有原生库已经拥有 CMakeLists.txt 构建脚本或者使用
ndk-build 并包含
Android.mk [https://developer.android.com/ndk/guides/android_mk.html]
构建脚本，则可以跳过此步骤。






	提供一个指向您的 CMake 或 ndk-build 脚本文件的路径，将 Gradle
关联到您的原生库。Gradle 使用构建脚本将源代码导入您的
Android Studio 项目并将原生库（SO 文件）封装到 APK 中。




配置完项目后，您可以使用 JNI
框架 [http://docs.oracle.com/javase/7/docs/technotes/guides/jni/spec/jniTOC.html]从
Java 代码中访问您的原生函数。要构建和运行应用，只需点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用。Gradle
会以依赖项的形式添加您的外部原生构建流程，用于编译、构建原生库并将其随
APK 一起封装。


创建新的原生源文件

要在应用模块的主源代码集中创建一个包含新建原生源文件的 cpp/
目录，请按以下步骤操作：


	从 IDE 的左侧打开 Project 窗格并从下拉菜单中选择 Project
视图。


	导航到您的模块 > src，右键点击 main 目录，然后选择 New >
Directory。


	为目录输入一个名称（例如 cpp）并点击 OK。


	右键点击您刚刚创建的目录，然后选择 New > C/C++ Source File。


	为您的源文件输入一个名称，例如 native-lib。


	从 Type 下拉菜单中，为您的源文件选择文件扩展名，例如 .cpp。


	点击 Edit File Types
[image: ../../_images/dialog-wrench.png]，您可以向下拉菜单中添加其他文件类型，例如
.cxx 或 .hxx。在弹出的 C/C++ 对话框中，从 Source
Extension 和 Header Extension
下拉菜单中选择另一个文件扩展名，然后点击 OK。






	如果您还希望创建一个标头文件，请选中 Create an associated header
复选框。


	点击 OK。







创建 CMake 构建脚本

如果您的原生源文件还没有 CMake
构建脚本，则您需要自行创建一个并包含适当的 CMake 命令。CMake
构建脚本是一个纯文本文件，您必须将其命名为
CMakeLists.txt。本部分介绍了您应包含到构建脚本中的一些基本命令，用于在创建原生库时指示
CMake 应使用哪些源文件。

注：如果您的项目使用 ndk-build，则不需要创建 CMake
构建脚本。提供一个指向您的
Android.mk [https://developer.android.com/ndk/guides/android_mk.html]
文件的路径，将 Gradle 关联到您的原生库。

要创建一个可以用作 CMake 构建脚本的纯文本文件，请按以下步骤操作：


	从 IDE 的左侧打开 Project 窗格并从下拉菜单中选择 Project
视图。


	右键点击您的模块的根目录并选择 New > File。

注：您可以在所需的任意位置创建构建脚本。不过，在配置构建脚本时，原生源文件和库的路径将与构建脚本的位置相关。



	输入“CMakeLists.txt”作为文件名并点击 OK。




现在，您可以添加 CMake 命令，对您的构建脚本进行配置。要指示 CMake
从原生源代码创建一个原生库，请将
cmake_minimum_required() [https://cmake.org/cmake/help/latest/command/cmake_minimum_required.html]
和
add_library() [https://cmake.org/cmake/help/latest/command/add_library.html]
命令添加到您的构建脚本中：

# Sets the minimum version of CMake required to build your native library.
# This ensures that a certain set of CMake features is available to
# your build.

cmake_minimum_required(VERSION 3.4.1)

# Specifies a library name, specifies whether the library is STATIC or
# SHARED, and provides relative paths to the source code. You can
# define multiple libraries by adding multiple add.library() commands,
# and CMake builds them for you. When you build your app, Gradle
# automatically packages shared libraries with your APK.

add_library( # Specifies the name of the library.
             native-lib

             # Sets the library as a shared library.
             SHARED

             # Provides a relative path to your source file(s).
             src/main/cpp/native-lib.cpp )





使用 add_library() 向您的 CMake 构建脚本添加源文件或库时，Android
Studio 还会在您同步项目后在 Project
视图下显示关联的标头文件。不过，为了确保 CMake
可以在编译时定位您的标头文件，您需要将
include_directories() [https://cmake.org/cmake/help/latest/command/include_directories.html]
命令添加到 CMake 构建脚本中并指定标头的路径：

add_library(...)

# Specifies a path to native header files.
include_directories(src/main/cpp/include/)





CMake 使用以下规范来为库文件命名：


lib库名称.so




例如，如果您在构建脚本中指定“native-lib”作为共享库的名称，CMake
将创建一个名称为 libnative-lib.so 的文件。不过，在 Java
代码中加载此库时，请使用您在 CMake 构建脚本中指定的名称：

    static {
        System.loadLibrary(“native-lib”);
    }





注：如果您在 CMake
构建脚本中重命名或移除某个库，您需要先清理项目，Gradle
随后才会应用更改或者从 APK
中移除旧版本的库。要清理项目，请从菜单栏中选择 Build > Clean
Project。

Android Studio 会自动将源文件和标头添加到 Project 窗格的 cpp
组中。使用多个 add_library() 命令，您可以为 CMake
定义要从其他源文件构建的更多库。


添加 NDK API

Android NDK 提供了一套实用的原生 API 和库。通过将 NDK
库 [https://developer.android.com/ndk/guides/stable_apis.html]包含到项目的
CMakeLists.txt 脚本文件中，您可以使用这些 API 中的任意一种。

预构建的 NDK 库已经存在于 Android 平台上，因此，您无需再构建或将其封装到
APK 中。由于 NDK 库已经是 CMake 搜索路径的一部分，您甚至不需要在您的本地
NDK 安装中指定库的位置 - 只需要向 CMake
提供您希望使用的库的名称，并将其关联到您自己的原生库。

将
find_library() [https://cmake.org/cmake/help/latest/command/find_library.html]
命令添加到您的 CMake 构建脚本中以定位 NDK
库，并将其路径存储为一个变量。您可以使用此变量在构建脚本的其他部分引用
NDK 库。以下示例可以定位 Android
特定的日志支持库 [https://developer.android.com/ndk/guides/stable_apis.html#a3]并将其路径存储在
log-lib 中：

find_library( # Defines the name of the path variable that stores the
              # location of the NDK library.
              log-lib

              # Specifies the name of the NDK library that
              # CMake needs to locate.
              log )





为了确保您的原生库可以在 log 库中调用函数，您需要使用 CMake
构建脚本中的
target_link_libraries() [https://cmake.org/cmake/help/latest/command/target_link_libraries.html]
命令关联库：

find_library(...)

# Links your native library against one or more other native libraries.
target_link_libraries( # Specifies the target library.
                       native-lib

                       # Links the log library to the target library.
                       ${log-lib} )





NDK
还以源代码的形式包含一些库，您在构建和关联到您的原生库时需要使用这些代码。您可以使用
CMake 构建脚本中的 add_library()
命令，将源代码编译到原生库中。要提供本地 NDK 库的路径，您可以使用
ANDROID_NDK 路径变量，Android Studio 会自动为您定义此变量。

以下命令可以指示 CMake 构建 android_native_app_glue.c，后者会将
NativeActivity [https://developer.android.com/reference/android/app/NativeActivity.html]
生命周期事件和触摸输入置于静态库中并将静态库关联到 native-lib：

add_library( app-glue
             STATIC
             ${ANDROID_NDK}/sources/android/native_app_glue/android_native_app_glue.c )

# You need to link static libraries against your shared native library.
target_link_libraries( native-lib app-glue ${log-lib} )








添加其他预构建库

添加预构建库与为 CMake
指定要构建的另一个原生库类似。不过，由于库已经预先构建，您需要使用
IMPORTED [https://cmake.org/cmake/help/latest/prop_tgt/IMPORTED.html#prop_tgt:IMPORTED]
标志告知 CMake 您只希望将库导入到项目中：

add_library( imported-lib
             SHARED
             IMPORTED )





然后，您需要使用
set_target_properties() [https://cmake.org/cmake/help/latest/command/set_target_properties.html]
命令指定库的路径，如下所示。

某些库为特定的 CPU 架构（或应用二进制接口
(ABI) [https://developer.android.com/ndk/guides/abis.html]）提供了单独的软件包，并将其组织到单独的目录中。此方法既有助于库充分利用特定的
CPU 架构，又能让您仅使用所需的库版本。要向 CMake 构建脚本中添加库的多个
ABI 版本，而不必为库的每个版本编写多个命令，您可以使用 ANDROID_ABI
路径变量。此变量使用 NDK 支持的一组默认
ABI [https://developer.android.com/ndk/guides/abis.html#sa]，或者您手动配置
Gradle 而让其使用的一组经过筛选的 ABI。例如：

add_library(...)
set_target_properties( # Specifies the target library.
                       imported-lib

                       # Specifies the parameter you want to define.
                       PROPERTIES IMPORTED_LOCATION

                       # Provides the path to the library you want to import.
                       imported-lib/src/${ANDROID_ABI}/libimported-lib.so )





为了确保 CMake 可以在编译时定位您的标头文件，您需要使用
include_directories() 命令，并包含标头文件的路径：

include_directories( imported-lib/include/ )





注：如果您希望封装一个并不是构建时依赖项的预构建库（例如在添加属于
imported-lib 依赖项的预构建库时），则不需要执行以下说明来关联库。

要将预构建库关联到您自己的原生库，请将其添加到 CMake 构建脚本的
target_link_libraries() 命令中：

target_link_libraries( native-lib imported-lib app-glue ${log-lib} )





在您构建应用时，Gradle 会自动将导入的库封装到 APK 中。您可以使用 APK
分析器 [https://developer.android.com/studio/build/apk-analyzer.html]验证
Gradle 将哪些库封装到您的 APK 中。如需了解有关 CMake
命令的详细信息，请参阅 CMake
文档 [https://cmake.org/cmake/help/latest/manual/cmake-commands.7.html]。






将 Gradle 关联到您的原生库 

要将 Gradle 关联到您的原生库，您需要提供一个指向 CMake 或 ndk-build
脚本文件的路径。在您构建应用时，Gradle 会以依赖项的形式运行 CMake 或
ndk-build，并将共享的库封装到您的 APK 中。Gradle
还使用构建脚本来了解要将哪些文件添加到您的 Android Studio
项目中，以便您可以从 Project
窗口访问这些文件。如果您的原生源文件没有构建脚本，则需要先创建 CMake
构建脚本，然后再继续。

将 Gradle 关联到原生项目后，Android Studio 会更新 Project 窗格以在
cpp 组中显示您的源文件和原生库，在 External Build Files
组中显示您的外部构建脚本。

注：更改 Gradle 配置时，请确保通过点击工具栏中的 Sync Project
[image: ../../_images/toolbar-sync-gradle.png]
应用更改。此外，如果在将 CMake 或 ndk-build 脚本文件关联到 Gradle
后再对其进行更改，您应当从菜单栏中选择 Build > Refresh Linked C++
Projects，将 Android Studio 与您的更改同步。


使用 Android Studio UI

您可以使用 Android Studio UI 将 Gradle 关联到外部 CMake 或 ndk-build
项目：


	从 IDE 左侧打开 Project 窗格并选择 Android 视图。


	右键点击您想要关联到原生库的模块（例如 app
模块），并从菜单中选择 Link C++ Project with
Gradle。您应看到一个如图 4 所示的对话框。


	从下拉菜单中，选择 CMake 或 ndk-build。


	如果您选择 CMake，请使用 Project Path 旁的字段为您的外部
CMake 项目指定 CMakeLists.txt 脚本文件。


	如果您选择 ndk-build，请使用 Project Path
旁的字段为您的外部 ndk-build 项目指定
Android.mk [https://developer.android.com/ndk/guides/android_mk.html]
脚本文件。如果
Application.mk [https://developer.android.com/ndk/guides/application_mk.html]
文件与您的 Android.mk 文件位于相同目录下，Android Studio
也会包含此文件。




[image: ../../_images/Figure%203.jpg]Figure3.jpg-86.4kB

**图 4.**使用 Android Studio 对话框关联外部 C++ 项目。



	点击 OK。







手动配置 Gradle

要手动配置 Gradle 以关联到您的原生库，您需要将 externalNativeBuild {}
块添加到模块级 build.gradle 文件中，并使用 cmake {} 或 ndkBuild {}
对其进行配置：

android {
  ...
  defaultConfig {...}
  buildTypes {...}

  // Encapsulates your external native build configurations.
  externalNativeBuild {
    // Encapsulates your CMake build configurations.
    cmake {

      // Provides a relative path to your CMake build script.
      path "CMakeLists.txt"
    }
  }
}





注：如果您想要将 Gradle 关联到现有 ndk-build 项目，请使用
ndkBuild {} 块而不是 cmake {}，并提供
Android.mk [https://developer.android.com/ndk/guides/android_mk.html]
文件的相对路径。如果
Application.mk [https://developer.android.com/ndk/guides/application_mk.html]
文件与您的
Android.mk [https://developer.android.com/ndk/guides/android_mk.html]
文件位于相同目录下，Gradle 也会包含此文件。


指定可选配置

您可以在模块级 build.gradle 文件的 defaultConfig {} 块中配置另一个
externalNativeBuild {} 块，为 CMake 或 ndk-build
指定可选参数和标志。与 defaultConfig {}
块中的其他属性类似，您也可以在构建配置中为每个产品风味重写这些属性。

例如，如果您的 CMake 或 ndk-build 项目定义多个原生库，您可以使用
targets
属性仅为给定产品风味构建和封装这些库中的一部分。以下代码示例说明了您可以配置的部分属性：

    android {
      ...
      defaultConfig {
        ...
        // This block is different from the one you use to link Gradle
        // to your CMake or ndk-build script.
        externalNativeBuild {

          // For ndk-build, instead use ndkBuild {}
          cmake {

            // Passes optional arguments to CMake.
            arguments "-DANDROID_ARM_NEON=TRUE", "-DANDROID_TOOLCHAIN=clang"

            // Sets optional flags for the C compiler.
            cFlags "-D_EXAMPLE_C_FLAG1", "-D_EXAMPLE_C_FLAG2"

            // Sets a flag to enable format macro constants for the C++ compiler.
            cppFlags "-D__STDC_FORMAT_MACROS"
          }
        }
      }

      buildTypes {...}

      productFlavors {
        ...
        demo {
          ...
          externalNativeBuild {
            cmake {
              ...
              // Specifies which native libraries to build and package for this
              // product flavor. If you don't configure this property, Gradle
              // builds and packages all shared object libraries that you define
              // in your CMake or ndk-build project.
              targets "native-lib-demo"
            }
          }
        }

        paid {
          ...
          externalNativeBuild {
            cmake {
              ...
              targets "native-lib-paid"
            }
          }
        }
      }

      // Use this block to link Gradle to your CMake or ndk-build script.
      externalNativeBuild {
        cmake {...}
        // or ndkBuild {...}
      }
    }





要详细了解配置产品风味和构建变体，请参阅配置构建变体 [https://developer.android.com/studio/build/build-variants.html]。如需了解您可以使用
arguments 属性为 CMake 配置的变量列表，请参阅使用 CMake
变量 [https://developer.android.com/ndk/guides/cmake.html#variables]。




指定 ABI 

默认情况下，Gradle 会针对 NDK 支持的
ABI [https://developer.android.com/ndk/guides/abis.html#sa]
将您的原生库构建到单独的 .so 文件中，并将其全部封装到您的 APK
中。如果您希望 Gradle 仅构建和封装原生库的特定 ABI 配置，您可以在模块级
build.gradle 文件中使用 ndk.abiFilters 标志指定这些配置，如下所示：

android {
  ...
  defaultConfig {
    ...
    externalNativeBuild {
      cmake {...}
      // or ndkBuild {...}
    }

    ndk {
      // Specifies the ABI configurations of your native
      // libraries Gradle should build and package with your APK.
      abiFilters 'x86', 'x86_64', 'armeabi', 'armeabi-v7a',
                       'arm64-v8a'
    }
  }
  buildTypes {...}
  externalNativeBuild {...}
}





在大多数情况下，您只需要在 ndk {} 块中指定
abiFilters（如上所示），因为它会指示 Gradle
构建和封装原生库的这些版本。不过，如果您希望控制 Gradle
应当构建的配置，并独立于您希望其封装到 APK 中的配置，请在
defaultConfig.externalNativeBuild.cmake {} 块（或
defaultConfig.externalNativeBuild.ndkBuild {} 块中）配置另一个
abiFilters 标志。Gradle 会构建这些 ABI 配置，不过仅会封装您在
defaultConfig.ndk{} 块中指定的配置。

为了进一步降低 APK 的大小，请考虑配置 ABI APK
拆分 [https://developer.android.com/studio/build/configure-apk-splits.html#configure-abi-split]，而不是创建一个包含原生库所有版本的大型
APK，Gradle 会为您想要支持的每个 ABI 创建单独的 APK，并且仅封装每个 ABI
需要的文件。如果您配置 ABI 拆分，但没有像上面的代码示例一样指定
abiFilters 标志，Gradle 会构建原生库的所有受支持 ABI
版本，不过仅会封装您在 ABI
拆分配置中指定的版本。为了避免构建您不想要的原生库版本，请为
abiFilters 标志和 ABI 拆分配置提供相同的 ABI 列表。













          

      

      

    

  

  
    
    实验目的
    

    
 
  

    
      
          
            
  #实验二. 板载LED灯控制实验




实验目的


	了解多核心平台底板设备电路结构;


	掌握Android Studio下编写NDK代码，实现LED灯控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现对板载5个LED灯的控制。







实验原理

  LED硬件原理及驱动移植请参见Linux实验文档LED驱动移植章节。  LED字符驱动程序(linux-3.5/drivers/char/4412_led.c)已动态编译进内核zImage里。
在Android文件系统中加载内核生成的module(4412_led.ko)会生成LED灯设备的文件(dev/leds)。  在Linux 系统中，所有设备都是以文件的形式被打开并进行读/写操作的。本实验中通过编写JNI层代码调用POSIX的文件接口函数对底层设备进行操作，实现上层应用程序控制LED灯亮灭。


本实验JNI编程时需要用到以下几个文件操作函数


OPEN - 打开设备


	【函数原型】

   #include <fcntl.h>
   int open(const char *pathname, int flags); 
   int open(const char *pathname, int flags, mode_t mode);







	【功能】打开名为path 的文件或设备，成功打开后返回文件句柄。


	【参数】pathname:文件路径或设备名；flags:打开方式，可选值是表4.1中的一个值或几个值的组合。




| 打开方式 |  含义 |
|:————-|:—————-|
| O_RDONLY | 只读方式打开 |
| O_WRONLY | 只写方式打开 |
| O_RDWR | 读写方式打开(等同于 O_RDONLY |  O_WRONLY) |
| … | … |
| O_NONBLOCK | 采用非阻塞文件I/O方式 |

表4.1 打开方式对照表


	【返回值】成功打开后返回文件句柄，失败返回-1。







IOCTL - 控制高低电平


	【函数原型】

      #include <unistd.h>
      int ioctl(int fildes, int request, /* arg */ ...);
      int ioctl(int fd, int ledState,int ledID);







	【功能】控制I/O设备(指定LED灯的亮灭)


	【参数】fildes：文件或设备句柄，通常由open函数返回；ledState:LED灯控制参数(0:灭/1:亮);ledID:5个led灯对应的ID。


	【返回值】成功返回0，失败返回错误码。







CLOSE - 关闭设备


	【函数原型】

      #include <unistd.h>
      int close(int fildes);







	【功能】关闭之前被打开的文件或设备


	【参数】fildes：文件或设备句柄，通常由open函数返回


	【返回值】成功返回0，失败返回-1。









JNI代码具体实现

在本实验中，需要使用1个设备文件：/dev/leds对多核心嵌入式平台的5个LED灯进行控制。


	打开LED设备

 #define DEVICE_NAME    "/dev/leds"
 ...
 fd = open(DEVICE_NAME, O_RDWR);//打开设备   







	调用IOCTL控制

 #define LED_ON 1
 #define LED_OFF 0
 ...
 ioctl(fd, LED_ON, ledID);  //打开指定ID的LED灯
 ...
 ioctl(fd, LED_OFF, ledID); //关闭指定ID的LED灯  







	关闭LED设备

 close(fd);














实验步骤


在Android Studio下创建支持C/C++的新项目

创建步骤参见本章实验一，本实验例程中创建的项目如图5.1所示。
[image: ../../_images/ch05_02.png]LED工程

图5.1 LED项目工程




更改库名及CMake构建脚本


	MainActivity更改加载库名称，注释掉stringFromJNI()相关调用。




    static {
        //System.loadLibrary("native-lib");
        System.loadLibrary("leds-jni");
    }
    ...
    //TextView tv = (TextView) findViewById(R.id.sample_text);
    //tv.setText(stringFromJNI());
    ...
    //public native String stringFromJNI();






	修改CMake构建配置文件




add_library( # Sets the name of the library.
             leds-jni
                ...
             src/main/jni/leds-jni.c )
             ...
target_link_libraries( # Specifies the target library.
                       leds-jni

                       ${log-lib} )             






	点击工具栏中的 Sync Project
[image: ../../_images/toolbar-sync-gradle.png]应用更改。







在MainActivity中添加LED操作的本地方法

//    public native String stringFromJNI();
    public native int ledsOpen();
    public native int ledsClose();
    public native int ledsControl(int ledID, int ledState);





在方法名中按下Alt+Enter，选择Create Function ...  > Fix all 'Missing JNI function' problems in file选项。项目src\main目录下会生成jni文件夹及leds-jni.c原生源文件。


	删除文件夹cpp及native-lib.cpp


	点击工具栏中的 Sync Project
[image: ../../_images/toolbar-sync-gradle.png]应用更改。







编写原生源文件leds-jni.c

按照实验原理中的接口方法编写实现对应的打开、控制及关闭功能。

#include <jni.h>
#include <fcntl.h>
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/leds"
#define LED_ON 1
#define LED_OFF 0
int fd;

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_leds_MainActivity_ledsControl(JNIEnv *env, jobject instance, jint ledID,
                                               jint ledState) {

    int i = ledState;
    switch (i) {
        case LED_ON:
            ioctl(fd, LED_ON, ledID);
            break;

        case LED_OFF:
            ioctl(fd, LED_OFF, ledID);
            break;

        default:
            break;
    }
    return 1;

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_leds_MainActivity_ledsClose(JNIEnv *env, jobject instance) {

    if (fd >= 0) {
        close(fd);
        fd = -1;
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_leds_MainActivity_ledsOpen(JNIEnv *env, jobject instance) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}








编写UI界面及代码


	将光盘目录src\chapter4\experiment02\res目录下的drawable、layout和values三个文件夹拷贝至本项目工程的res目录下。


	打开activity_main.xml界面如图5.1所示：
[image: ../../_images/activity_main.png]主界面




图5.1 主界面


	编写MainActivity主程序,_参考代码_如下：




    public static final int LED_ON = 1;
    public static final int LED_OFF = 0;
    public static final int LED1 = 0;
    public static final int LED2 = 1;
    public static final int LED3 = 2;
    public static final int LED4 = 3;
    public static final int LED5 = 4;
    ImageView ivLed1, ivLed2, ivLed3, ivLed4, ivLed5;
    Switch swLed1, swLed2, swLed3, swLed4, swLed5;
    ...
  private void LayoutInit() {
        ivLed1 = (ImageView) findViewById(R.id.iv_led1);
        ...
        ivLed5 = (ImageView) findViewById(R.id.iv_led5);
        swLed1 = (Switch) findViewById(R.id.sw_led1);
        ...
        swLed5 = (Switch) findViewById(R.id.sw_led5);
        swLed1.setOnCheckedChangeListener(this);
        ...
        swLed5.setOnCheckedChangeListener(this);
    }

    @Override
    public void onCheckedChanged(CompoundButton compoundButton, boolean b) {
        switch (compoundButton.getId()) {
            case R.id.sw_led1:
                if (b) {
                    ledsControl(LED1, LED_ON);
                    ivLed1.setImageResource(R.drawable.ic_led_on);
                } else {
                    ledsControl(LED1, LED_OFF);
                    ivLed1.setImageResource(R.drawable.ic_led_off);
                }
                break;
           ...
            case R.id.sw_led5:
                if (b) {
                    ledsControl(LED5, LED_ON);
                    ivLed5.setImageResource(R.drawable.ic_led_on);
                } else {
                    ledsControl(LED5, LED_OFF);
                    ivLed5.setImageResource(R.drawable.ic_led_off);
                }
                break;
        }

    }





具体实现细节可参考光盘目录下相应实验源码。


	构建和运行示例程序




操作应用程序之前需将多核心平台底板5路LED灯左侧的跳线帽跳到LED处，如图5.2所示：

[image: ../../_images/led_jumper_cap.png]LED跳线帽

图5.2 LED跳线帽




演示运行

运行程序后，首先点击加载驱动(modules)按键，会弹出如图5.3对话框，请求获取超级用户权限，点击授权。

[image: ../../_images/load_modules.png]加载驱动

图5.3 加载驱动

点击右侧的打开按钮会调用ledsOpen()方法打开LED设备。
Android Studio界面下方的Android Monitor里的logcat会打印如下信息：

01-01 13:41:15.655 29662-29662/cbt.edu.iot.leds I/libs: open device /dev/leds ok! 





之后便可以点击下方的Switch按钮，对5个LED灯进行控制，如图5.4所示：

[image: ../../_images/led1_control.png]LED灯控制

图5.4 LED灯控制
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实验三. 八段数码管控制实验




实验目的


	了解多核心平台底板设备电路结构;


	掌握Android Studio下编写NDK代码，实现数码管的控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现对板载2路八段数码管的控制。







实验原理


主板电路原理图

[image: ../../_images/Nixie.png]数码管

图4.1 原理图

  首先为了在单独的一位数字上显示出我们想要的数字，要根据数码管每一位所对应的引脚输入正确的值。一个数码管数字一共由7个长直型的发光二极管组成，分别被以”A”-“G”的英文字母编号，右下角的小数点用“DP”编号。点亮一个数码管的电路跟点亮一个普通发光二极管没什么两样，就是在高低电压之间让数码管和一个分压电阻串联，因此想要点亮带小数点的一个十进制数，需要由8个并联的发光二极管电路来完成。

  那么如果想同时点亮两个数字，是不是需要8X2=16个并联电路呢？
  实际上一般的数码管都不使用如此复杂的电路，而是利用人眼的“视觉暂留”效应，通过快速切换数码管的显示，达到多位数字的显示目的。这时，只需要每个数字的阳极或阴极列作为公共控制引脚，就可以控制每个数字的显示。

图4.1中的内部电路是共阴极数码管的电路，每8组数码管有一个公共阴极，同一时刻，只允许一个数字发亮，当两个数字中快速切换，便可形成多位数字同时显示的效果。




驱动实现

  每个数字当我们想让他亮的时候，将对应的阴极置为低电平即可。可得出下列二维数组：

unsigned char table[10][8] =
{
    {1, 1,  0,  0,  0,  0,  0,  0},         //0 --> 0xc0
    {1, 1,  1,  1,  1,  0,  0,  1},         //1 --> 0xf9
    {1, 0,  1,  0,  0,  1,  0,  0},         //2 --> 0xa4
    {1, 0,  1,  1,  0,  0,  0,  0},         //3 --> 0xb0
    {1, 0,  0,  1,  1,  0,  0,  1},         //4 --> 0x99
    {1, 0,  0,  1,  0,  0,  1,  0},         //5 --> 0x92
    {1, 0,  0,  0,  0,  0,  1,  0},         //6 --> 0x82
    {1, 1,  1,  1,  1,  0,  0,  0},         //7 --> 0xf8
    {1, 0,  0,  0,  0,  0,  0,  0},         //8 --> 0x80
    {1, 0,  0,  1,  0,  0,  0,  0}          //9 --> 0x90
};





  以上的代码分别对应了0-9的数字在数码管上的显示IO管脚电平，按照顺时针方向，从8字顶端开始为ABCDEFG，DP，而代码中从高到低对应DP,GFEDCBA。

  数码管底层驱动为字符驱动，采用动态编译(4412_digitron.ko)方式,加载后设备名为/dev/digitron。




接口函数

int open(const char *pathname, int flags); //同实验二LED
int close(int fildes);//同实验二LED
int ioctl(int fd, int number); //number为上述二维数组中对应的十六进制数值





这样数码管设备/dev/digitron通过ioctl赋值既可显示相应数字。示例：

//显示`0`(0xc0)
ioctl(fd, 0xc0);












<<<<<<< 7b647ecd48083c061990cc45d99435d8d21646a7


实验步骤

###JNI中间层程序编写

从实验原理相关接口函数介绍，编写digitron-jni.c代码参考如下：

#include <jni.h>
#include <fcntl.h>  
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/digitron"
#define ZERO  0xc0
#define ONE  0xf9
#define TWO  0xa4
#define THREE  0xb0
#define FOURE  0x99
#define FIVE  0x92
#define SIX  0x82
#define SEVEN  0xf8
#define EIGHT  0x80
#define NINE  0x90
int fd;

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_nixie_MainActivity_closeDigitron(JNIEnv *env, jclass type) {
    if (fd >= 0) {
        close(fd);
        fd = -1;
    }
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_nixie_MainActivity_setDigitronValue(JNIEnv *env, jclass type, jint digitValue) {

    int i = digitValue;
    switch (i) {
        case 0:
            ioctl(fd, ZERO);
            break;
      ...
        case 9:
            ioctl(fd, NINE);
            break;
    }
    return 1;

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_nixie_MainActivity_openDigitronDriver(JNIEnv *env, jclass type) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_03_8_SegmentLED,如图5.2.1所示：




[image: ../../_images/ch05_03.png]数码管工程

图5.2.1 8段数码管工程




演示运行


	运行前需将平台主板JP18处的跳线帽跳至_数码管_一侧。




[image: ../../_images/nixie_jumper_cap.png]数码管跳线帽

图5.3.1 数码管跳线帽


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序，界面如图5.3.2所示：




[image: ../../_images/ch05_03_ui_01.png]ui01

图5.3.2 主界面


	点击加载驱动按钮，弹窗请求权限点击授权。之后会在系统中生成字符驱动/dev/digitron。


	点击右侧打开按钮后即可操作该驱动。点击下方的两个按键图标即可同步控制两个8段数码管中的数值。如图5.3.2所示：




[image: ../../_images/ch05_03_ui_03.png]ui03
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    实验四. 步进电机控制实验
    

    
 
  

    
      
          
            
  
实验四. 步进电机控制实验




实验目的


	了解多核心平台底板设备电路结构;


	掌握Android Studio下编写NDK代码，实现步进电机的控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现对步进电机的控制。







实验原理


	硬件原理及驱动移植参见Linux光盘中的步进电机实验。


	驱动底层预留接口如下：




int open(const char *pathname, int flags); 
int close(int fildes);
int ioctl(int fd, int step,int delaytime); //delaytime：延迟时间，控制转速






	底层驱动采用四拍驱动正反转。示例:




static int forward[] = {1, 20, 4, 8}; //正传
static int rollback[] = {8, 4, 20, 1};//反转

 for (int i = 0; i < 4; i++) {  //正传
        ioctl(fd, forward[i], delay);
    }








实验步骤

###JNI中间层程序编写

从实验原理相关接口函数介绍，编写steppermoter-jni.c代码参考如下：

#include <jni.h>
#include <fcntl.h>  
#include <unistd.h>
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/StepMoto"

int fd;
static int forward[] = {1, 20, 4, 8};

static int rollback[] = {8, 4, 20, 1};

static

void Motor_Forward(long delay) {

    for (int i = 0; i < 4; i++) {
        ioctl(fd, forward[i], delay);
    }
}

void Motor_Rollback(long delay) {

    for (int i = 0; i < 4; i++) {
        ioctl(fd, rollback[i], delay);
    }
}


JNIEXPORT jint JNICALL
Java_cbt_edu_iot_steppermoter_MainActivity_moterInit(JNIEnv *env, jobject instance) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_steppermoter_MainActivity_moterStepForeward(JNIEnv *env, jobject instance,
                                                             jint count, jlong delay
) {

    for (int i = 0; i < count; i++) {
        Motor_Forward(delay);
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_steppermoter_MainActivity_moterStepRollback(JNIEnv *env, jobject instance,
                                                             jint count, jlong delay
) {

    for (int i = 0; i < count; i++) {
        Motor_Rollback(delay);
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_steppermoter_MainActivity_moterExit(JNIEnv *env, jobject instance) {

    if (fd >= 0) {
        close(fd);
        fd = -1;
    }
}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_04_StepperMoter。







演示运行


	运行前需将平台主板MOTOR的拨码开关拨到ON上供电。


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	点击加载驱动按钮，弹窗请求权限点击授权。之后会在系统中生成字符驱动/dev/StepMoto。


	点击右侧打开按钮后即可操作该驱动。点击下方的两个按钮控制其正反转。如图5.3.1所示：




[image: ../../_images/ch05_04_ui.png]ui
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实验五. 基于ADC接口的旋转编码器器及光敏电阻开发实验




实验目的


	熟悉ADC原理;


	掌握Android Studio下编写NDK代码，获取ADC设备相应数据;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现旋转编码器器及光敏电阻数据的获取。







实验原理


硬件原理


模数转换器即A/D转换器，或简称ADC，通常是指一个将模拟信号转变为数字信号的电子元件。通常的模数转换器是把经过与标准量比较处理后的模拟量转换成以二进制数值表示的离散信号的转换器。故任何一个模数转换器都需要一个参考模拟量作为转换的标准，比较常见的参考标准为最大的可转换信号大小。而输出的数字量则表示输入信号相对于参考信号的大小。







驱动实现

ADC驱动已静态编译进内核，系统启动后生成的设备名为/dev/adc。
ADC通道0接收旋转编码器数据，通道1接收光敏电阻数据。




接口函数

int open(const char *pathname, int flags); 
int close(int fildes);
int ioctl(int fd, int ADC_SET_CHANNEL,int channel); //设置adc通道0~1
ssize_t read(int fd, void *buf, size_t count);//读取adc数组










实验步骤

###JNI中间层程序编写

从实验原理相关接口函数介绍，编写adc-jni.c代码参考如下：

#include <jni.h>
#include <fcntl.h>  
#include <stdio.h>
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/adc"
#define ADC_SET_CHANNEL     0xc000fa01
int fd;
float valt = 0;
JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1adc_MainActivity_adcInit(JNIEnv *env, jclass type) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1adc_MainActivity_adcSetChannel(JNIEnv *env, jclass type, jint channel) {

   int ret =  ioctl(fd, ADC_SET_CHANNEL, channel);
    if(ret < 0){
        LOGI("% set channel failed",DEVICE_NAME);
    }

}


JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1adc_MainActivity_adcExit(JNIEnv *env, jclass type) {
    if (fd >= 0) {
        close(fd);
        fd = -1;
    }
}

JNIEXPORT jfloat JNICALL
Java_cbt_edu_iot_cbt4412_1adc_MainActivity_adcRead(JNIEnv *env, jclass type) {

    char buffer[30];
    int len = read(fd, buffer, sizeof buffer -1);
    if (len > 0) {
        buffer[len] = '\0';
        int value = -1;
        sscanf(buffer, "%d", &value);
        valt = value;
        return  valt;
        usleep(1* 1000);
    } else {
        LOGE("read ADC device:","failed");
        return 1;
    }
}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_05_ADC。







演示运行


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。界面中会显示旋转编码器及光敏电阻的数据，如图5.3.1所示：




[image: ../../_images/ch05_05_ui.png]ui

图5.3.1 ADC

拨动编码器旋钮/用手遮住光敏电阻操作可观察到界面中数值的变化。
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实验六. 基于PWM的无源蜂鸣器控制实验




实验目的


	了解PWM原理;


	掌握Android Studio下编写NDK代码，实现蜂鸣器的控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现对蜂鸣器的控制。







实验原理


	硬件原理及驱动移植参见Linux光盘中的PWM实验。


	驱动底层预留接口如下：




int open(const char *pathname, int flags); 
int close(int fildes);
int ioctl(int fd, int step,int delaytime); 
int ioctl(int fd, int PWM_IOCTL_SET_FREQ, int frequency);
int ioctl(int fd, int PWM_IOCTL_STOP);





通过调节PWM的频率实现声音大小的控制；通过ioctl传递stop参数实现播放/暂停功能。




实验步骤

###JNI中间层程序编写

从实验原理相关接口函数介绍，编写buzzer-jni.c代码参考如下：

#include <jni.h>
#include <fcntl.h>  //文件操作相关函数
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/pwm"
#define PWM_IOCTL_SET_FREQ       1
#define PWM_IOCTL_STOP            0
int fd;

JNIEXPORT jboolean JNICALL
Java_cbt_edu_iot_cbt4412_1buzzer_MainActivity_buzzerInit(JNIEnv *env, jclass type) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1buzzer_MainActivity_buzzerSet(JNIEnv *env, jclass type, jint frequency) {

    int ret = ioctl(fd, PWM_IOCTL_SET_FREQ, frequency);
    if (ret < 0) {
        LOGI("set the frequency of the buzzer", "");
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1buzzer_MainActivity_buzzerStop(JNIEnv *env, jclass type) {

    int ret = ioctl(fd, PWM_IOCTL_STOP);
    if (ret < 0) {
        LOGI("stop the %s success \n", DEVICE_NAME);
    }
    if (ioctl(fd, 2) < 0) {
        LOGI("ioctl 2:", "");
    }

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_cbt4412_1buzzer_MainActivity_buzzerExit(JNIEnv *env, jclass type) {

    if (fd >= 0) {
        ioctl(fd, PWM_IOCTL_STOP);
        if (ioctl(fd, 2) < 0) {
            LOGI("ioctl 2:", "");
        }
        close(fd);
        fd = -1;
    }

}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_06_Buzzer。







演示运行


	运行前需将蜂鸣器旁边的跳线帽跳到BUZZER位置。


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	点击加载驱动按钮，弹窗请求权限点击授权。之后会在系统中生成字符驱动/dev/pwm。


	点击右侧打开按钮后即可操作该驱动。点击下方按钮控制其音量加减及播放暂停。如图5.3.1所示：




[image: ../../_images/ch05_06_ui.png]ui









          

      

      

    

  

  
    
    实验七. 基于PWM控制的直流电机驱动实验
    

    
 
  

    
      
          
            
  
实验七. 基于PWM控制的直流电机驱动实验
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实验八. 红外接收实验




实验目的


	了解Android用户输入系统框架;


	掌握上层获取输入事件的方法;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写上层程序，实现获取红外遥控器传入的事件信息。







实验原理

内核中已移植红外驱动，实现红外遥控解码，将遥控器上的按键解码出键值并上报给系统。属于input设备，工作原理类似于键盘。
驱动实现细节可参见红外驱动移植实验章节。

Android输入系统框图如图4.1所示：

[image: ../../_images/android_input_system.jpg]Android输入系统结构

图4.1 Android输入系统结构

自下而上，Android的用户输入系统分成几个部分：

驱动程序：在/dev/input目录中，通常是Event类型的驱动程序

EventHub：本地框架层的EventHub是libui中的一部分，它实现了对驱动程序的控制，并从中获得信息

KeyLayout（按键布局）和KeyCharacterMap（按键字符映射）文件。同时，libui中有相应的代码对其操作。定义按键布局和按键字符映射需要运行时配置文件的支持，它们的后缀名分别为kl和kcm

Java框架层的处理：在Java框架层具有KeyInputDevice等类用于处理由EventHub传送上来的信息，通常信息由数据结构RawInputEvent和KeyEvent来表示。通常情况下，对于按键事件，则直接使用KeyEvent来传送给应用程序层，对于触摸屏和轨迹球等事件，则由RawInputEvent经过转换后，形成MotionEvent时间传送给应用程序层

在Android的应用程序层中，通过重新实现onTouchEvent和onTrackballEvent等函数来接收运动事件（MotionEvent），通过重新实现onKeyDown和onKeyUp等函数来接收按键事件（KeyEvent）。这些类包含在android.view包中。

本地框架层底层已实现，本实验主要为编写上层应用层获取红外事件信息。




实验步骤


	新建普通Android工程


	在MainActivity中重新系统方法onKeyDown，代码如下：




  @Override
    public boolean onKeyDown(int keyCode, KeyEvent event) {
        textView.setText("KeyEvent: " + event.toString());
        return true;
    }






	编译运行


	使用内核中已经支持的遥控器对着平台主板上的红外接收头按下任意按键，在界面中会显示该按键的相应信息。如图5.1所示：




[image: ../../_images/ch05_08_ui.png]红外按键事件

图5.1 红外按键事件信息







          

      

      

    

  

  
    
    实验九. 基于IIC接口的ADXL345三轴加速度开发实验
    

    
 
  

    
      
          
            
  
实验九. 基于IIC接口的ADXL345三轴加速度开发实验




实验目的


	了解IIC驱动;


	掌握Android Studio下编写NDK代码，实现获取三轴加速度的数值;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现获取三轴加速度的数值。







实验原理


IIC驱动体系

体系结构包括：IIC总线驱动；IIC核心；IIC从设备驱动。


	I2C核心




IIC 核心提供了IIC总线驱动和设备驱动的注册、注销方法，IIC通信方法（即“algorithm”），与具体适配器无关的代码以及探测设备、检测设备地址等。i2c-core.c中的核心驱动程序可管理多个IIC总线适配器（控制器）和多个IIC从设备。每个IIC从设备驱动都能找到和它相连的IIC总线适配器。


	IIC总线驱动




IIC总线驱动主要包括IIC适配器结构i2c_adapter和I2C适配器的algorithm数据结构。

通过IIC总线驱动的代码，可控制IIC适配器以主控方式产生开始位、停止位、读写周期，以及以从设备方式被读写、产生ACK等。


	IIC设备驱动




IIC设备驱动是对IIC设备端的实现，设备一般挂接在受CPU控制的I2C适配器上，通过IIC适配器与CPU交换数据。IIC设备驱动主要包括数据结构i2c_driver和i2c_client。




ADXL345驱动实现

IIC驱动体系中一般来说硬件上可含有一个或多个从设备，一个或多个适配器，这俩之间的关系：一个适配器可以控制多个从设备；且我们既可以通过直接编写从设备驱动来操控他，也可以通过操作适配器来操控从设备。

I2C总线的设备文件通常为/dev/i2c-n（n=0、1、2……），每个设备文件对应一组I2C总线。应用程序通过这些设备文件可以操作I2C总线上的任何从机器件。

本实例中ADXL345设备采用IIC总线驱动的方式。通过操作控制器来产生特定的IIC时序信号，来发送和接收数据，让适配器工作。




IIC编程接口

由于采用总线驱动方式，需调用i2c.h及i2c-dev.h这两个头文件。使用到的系统方法有：

/* This is the structure as used in the I2C_SMBUS ioctl call */
struct i2c_smbus_ioctl_data {
    __u8 read_write;
    __u8 command;
    __u32 size;
    union i2c_smbus_data __user *data;
};

/*
 * Data for SMBus Messages
 */
#define I2C_SMBUS_BLOCK_MAX 32  /* As specified in SMBus standard */
union i2c_smbus_data {
    __u8 byte;
    __u16 word;
    __u8 block[I2C_SMBUS_BLOCK_MAX + 2]; /* block[0] is used for length */
                   /* and one more for user-space compatibility */
};






	打开设备




在操作I2C总线时，先调用open()函数打开I2C设备获得文件描述符，代码如下所示。

打开I2C设备文件

int fd;
fd = open("/dev/i2c-0", O_RDWR); 
if (fd < 0) {
perror("open i2c-1 n");
}






	关闭设备




当操作完成后，调用close()函数关闭设备：

close(fd);






	配置设备




当应用程序操作I2C总线上的从机器件时，必须先调用ioctl()函数设置从机地址和从机地址的长度。

设置从机地址

设置从机地址是使用I2C_SLAVE命令，其定义为：

#define I2C_SLAVE 0x0703





该命令的参数为从机地址右移一位。设置从机地址为0xA0的示例代码为：

if (ioctl(GiFd, I2C_SLAVE, 0xA0>> 1)< 0) {
perror("set slave address failen");
}





注意：地址需要右移一位，是因为地址的Bit0是读写控制位，在驱动中会将从机地址命令参数左移一位，并补上读写控制位。

设置地址长度

设置从机地址的长度是使用I2C_TENBIT命令，其定义为：

#define I2C_TENBIT 0x0704





该命令的参数可选择为：1表示设置从机地址长度为10位；0表示设置从机地址长度为8位。设置从机地址长度为10位的示例代码为：

ioctl(fd, I2C_TENBIT, 1);





该命令是不会返回错误的。

如果不设置地址长度，则默认为8位地址。


	发送/接收数据




通过调用系统方法ioctl传递不同参数args实现数据读写。

ioctl(file, I2C_SMBUS, &args);





封装函数如下：

static inline __s32 i2c_smbus_access(int file, char read_write, __u8 command,
                                     int size, union i2c_smbus_data *data) {
    struct i2c_smbus_ioctl_data args;

    args.read_write = read_write;
    args.command = command;
    args.size = size;
    args.data = data;
    return ioctl(file, I2C_SMBUS, &args);
}










实验步骤

###JNI中间层编程范例

从实验原理相关接口函数介绍，编写adxl345-jni.c代码参考如下：

#include <jni.h>
#include <fcntl.h>
#include <stdio.h>
#include <unistd.h>
//#include <linux/i2c-dev.h>
//#include <linux/i2c.h>

#include "android/log.h"
#include "i2c-dev.h"
#include "i2c.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/dev/i2c-0"
#define I2C_SLAVE       0x0703  /* Use this slave address */
#define I2C_TENBIT      0x0704
#ifndef uchar
#define uchar unsigned char
#endif
int fd, n, res;
unsigned char id;
unsigned char dataxh = 0;
unsigned char dataxl = 0;
unsigned char datayh = 0;
unsigned char datayl = 0;
unsigned char datazh = 0;
unsigned char datazl = 0;
unsigned int datax = 0;
unsigned int datay = 0;
unsigned int dataz = 0;
float x, y, z;
uchar set1_buffer[7] = {0x0B, 0x0B, 0x08, 0x80, 0x00, 0x00, 0x00};  ////adxl345设置
//参数
uchar reg1_buffer[7] = {0x31, 0x2c, 0x2d, 0x2e, 0x1e, 0x1f, 0x20};

static inline __s32 i2c_smbus_access(int file, char read_write, __u8 command,
                                     int size, union i2c_smbus_data *data) {
    struct i2c_smbus_ioctl_data args;

    args.read_write = read_write;
    args.command = command;
    args.size = size;
    args.data = data;
    return ioctl(file, I2C_SMBUS, &args);
}

static inline __s32 i2c_smbus_read_byte_data(int file, __u8 command) {
    union i2c_smbus_data data;
    if (i2c_smbus_access(file, I2C_SMBUS_READ, command,
                         I2C_SMBUS_BYTE_DATA, &data)) {
        printf("no data\n");
        return -1;
    }
    else {
        //printf("datatmp:%02x\n",data.byte);
        return 0x0FF & data.byte;
    }
}

static inline __s32 i2c_smbus_write_byte_data(int file, __u8 command,
                                              __u8 value) {
    union i2c_smbus_data data;
    data.byte = value;
    return i2c_smbus_access(file, I2C_SMBUS_WRITE, command,
                            I2C_SMBUS_BYTE_DATA, &data);
}

static int read_adxl345(int fd, __u8 buff[], int addr, int count) {
    int res;

    buff[0] = i2c_smbus_read_byte_data(fd, addr);

    //res=read(fd,buff,count);
    return res;
}

static int write_adxl345(int fd, __u8 data, int addr/*, int count*/) {
    int i = i2c_smbus_write_byte_data(fd, addr, data);
    if (i < 0)
        printf("write error\n");
}

int toPrimary(unsigned int data) {
    int temp = 0;
    if (data & 0x8000) {
        temp = data ^ 0xffff;
        temp -= 1;
        return temp * (-1);
    }
    else
        temp = data;
//   printf("temp:%02x\n",temp);
    return temp;
}


JNIEXPORT jint JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345Init(JNIEnv *env, jclass type) {
    res = ioctl(fd, I2C_TENBIT, 0); //not 10bit
    res = ioctl(fd, I2C_SLAVE, 0x53); //0x53为 ADXL345 IIC设备地址
    write_adxl345(fd, *(set1_buffer + 0),
                  reg1_buffer[0]);//数据格式控制,禁用自测力>，中断高电平有效，全分辨率模式（正负16g，13 bit），右对齐并带符号扩展
    write_adxl345(fd, *(set1_buffer + 1),
                  reg1_buffer[1]);//非低功耗模式，器件带宽为12.5Hz，输出数据速率为25Hz；（默认带宽50，速率100 ）
    write_adxl345(fd, *(set1_buffer + 2), reg1_buffer[2]);//静止功能和活动功能同时打开，禁止自动切换至休眠模式，测量模式，不休眠
    write_adxl345(fd, *(set1_buffer + 3), reg1_buffer[3]);
    write_adxl345(fd, *(set1_buffer + 4), reg1_buffer[4]);//X 偏移量
    write_adxl345(fd, *(set1_buffer + 5), reg1_buffer[5]);//Y 偏移量
    write_adxl345(fd, *(set1_buffer + 6), reg1_buffer[6]);//Z 偏移量
    write_adxl345(fd, 0x4f, 0x38);
    write_adxl345(fd, 0x00, 0x2e); //所有中断均关闭
    write_adxl345(fd, 0x00, 0x2f); //INT1

    write_adxl345(fd, 0x00, 0x28); //不使用FIFO
    read_adxl345(fd, &id, 0x00, 1);
    LOGI("adxl345 chip ID = %x \n", id);

}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345_1open(JNIEnv *env, jclass type) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }

}

JNIEXPORT jfloat JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345_1getAccel_1x(JNIEnv *env, jclass type) {

    read_adxl345(fd, &dataxl, 0x32, 1);
    read_adxl345(fd, &dataxh, 0x33, 1);
    datax=dataxh*256+dataxl;
    x=toPrimary(datax)*0.0039;
    return x;
}

JNIEXPORT jfloat JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345_1getAccel_1y(JNIEnv *env, jclass type) {

    read_adxl345(fd, &datayl, 0x34, 1);
    read_adxl345(fd, &datayh, 0x35, 1);
    datay=datayh*256+datayl;
    y=toPrimary(datay)*0.0039;
    return y;
}

JNIEXPORT jfloat JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345_1getAccel_1z(JNIEnv *env, jclass type) {

    read_adxl345(fd, &datazl, 0x36, 1);
    read_adxl345(fd, &datazh, 0x37, 1);
    dataz=datazh*256+datazl;
    z=toPrimary(dataz)*0.0039;
    return z;
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_adxl345_MainActivity_adxl345Exit(JNIEnv *env, jclass type) {

    if (fd >= 0) {
        close(fd);
        fd = -1;
    }

}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_09_ADXL345。







演示运行


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	界面会显示当前多核心平台设备的三轴加速度实时数值，如图5.3.1所示：




[image: ../../_images/ch05_09_ui.png]adxl345界面

图5.3.1 主界面


	ADXL345用户手册中输出响应与相对于重力的方向的关系如图5.3.2所示：




[image: ../../_images/ch05_09_adxl345.png]方向

图5.3.2 输出响应与相对于重力的方向的关系
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实验十. 基于IIC总线的EEPROM读写实验




实验目的


	熟悉IIC设备驱动，能够通过JNI对IIC从设备EEPROM进行读写操作;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	学习IIC设备驱动，然后使用Android Stuido创建JNI项目操作IIC从设备来控制EEPROM。







实验原理

从第四章.《实验二. 基于IIC总线的EEPROM驱动移植实验》章节中可了解到系统启动后会在目录/sys/devices/platform/s3c2440-i2c.0/i2c-0/0-0050/下生成eeprom的一个普通文件。

因此，可以通过在JNI层编写I/O操作的相关代码即可完成对EEPROM的读写。




实验步骤

###JNI中间层编程范例

#include <jni.h>
#include <fcntl.h>
#include<unistd.h>
#include<sys/ioctl.h>
#include<stdlib.h>
#include<fcntl.h>
#include "android/log.h"

static const char *TAG = "libs";
#define LOGI(fmt, args...) __android_log_print(ANDROID_LOG_INFO,  TAG, fmt, ##args)
#define LOGD(fmt, args...) __android_log_print(ANDROID_LOG_DEBUG, TAG, fmt, ##args)
#define LOGE(fmt, args...) __android_log_print(ANDROID_LOG_ERROR, TAG, fmt, ##args)

#define DEVICE_NAME    "/sys/devices/platform/s3c2440-i2c.0/i2c-0/0-0050/eeprom"
int fd;
#define LEN 256
char read_data[LEN];
char write_data[LEN];
char offset[LEN];

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1Init(JNIEnv *env, jclass type) {

    fd = open(DEVICE_NAME, O_RDWR);//打开设备
    if (fd == -1) {
        LOGI("open device %s error \n", DEVICE_NAME);
        lseek64(fd, 0, SEEK_SET);//调整偏移量，从开始位置读写
        return 0;
    }
    else {
        LOGI("open device %s ok! \n", DEVICE_NAME);
        return 1;
    }
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1Close(JNIEnv *env, jclass type) {

    if (fd >= 0) {
        close(fd);
        fd = -1;
    }
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1readByteFromI2C(JNIEnv *env, jclass type, jint pos,
                                                             jint wait_m) {
    lseek64(fd, 0, SEEK_SET);//重新设置偏移量从起始位置读取
    int ret, i;
    ret = read(fd, offset, 256);
    if (ret < 0) {
        LOGE("read failed. \n", "");
        return -1;
    }
    strncpy(read_data, offset, sizeof(offset));
    usleep(wait_m * 1000);
    return read_data[pos];
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1writeByteToI2C(JNIEnv *env, jclass type, jint pos,
                                                            jbyte byteData, jint wait_m) {
    int ret;
    write_data[pos] = byteData;
    lseek64(fd, 0, SEEK_SET);//调整偏移量，从开始位置写入
    if (byteData != 0) {
        ret = write(fd, write_data, pos + 1);  
        lseek(fd, pos + 1, SEEK_CUR);
    }

    if (ret < 0) {
        LOGE("Write error\n", "");
        return -1;
    }//将指定数据写入当前EEPROM中
    usleep(wait_m * 1000);
    return ret;
}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1erase(JNIEnv *env, jclass type) {
    int ret;

    lseek64(fd, 0, SEEK_SET);
    memset(write_data, 0, sizeof(write_data));
    ret = write(fd, write_data, sizeof(write_data));
    if (ret < 0) {
        LOGE("Erase error\n", "");
        return -1;
    }
    lseek64(fd, 0, SEEK_SET);
    return ret;


}

JNIEXPORT jint JNICALL
Java_cbt_edu_iot_eeprom_MainActivity_eeprom_1write(JNIEnv *env, jclass type, jbyteArray writeBytes_,
                                                   jint len) {
    //获取数组指针和长度
    jbyte *writeBytes = (*env)->GetByteArrayElements(env, writeBytes_, NULL);
    // 释放内存
    (*env)->ReleaseByteArrayElements(env, writeBytes_, writeBytes, 0);
    int ret;
    lseek64(fd, 0, SEEK_SET);
    ret = write(fd, writeBytes, len);
    usleep(10 * 1000);
    lseek64(fd, 0, SEEK_SET);

    if (ret < 0) {
        LOGE("Write error\n", "");
        return -1;
    }//将指定数据写入当前EEPROM中

    return ret;
}






导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_10_EEPROM。







演示运行


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	点击界面中的WRITE EEPROM按钮，将下方的文本写入EEPROM中，下方Status会显示当前操作的返回结果，如图5.3.1所示：




[image: ../../_images/ch05_10_ui01.png]主界面

图5.3.1 主界面


	点击右侧的READ EEPROM按钮读取当前EEPROM中的数据，下方Status会实时显示当前读取到的数据的长度，如图5.3.2所示：




[image: ../../_images/ch05_10_ui02.png]读取数据

图5.3.2 读取数据


	点击下方的ERASE EEPROM会清空EEPROM中的数据。




说明:本示例代码中未对中文字符做处理。









          

      

      

    

  

  
    
    实验十一. 基于IIC接口的FM收音机开发实验
    

    
 
  

    
      
          
            
  
实验十一. 基于IIC接口的FM收音机开发实验




实验目的


	掌握使用IIC对FM模块进行控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	编写NDK程序，实现控制收音机模块。







实验原理

本实验中使用的收音机芯片为飞利浦生产的TEA5767。


硬件连接

[image: ../../_images/tea5767.png]连接电路

图4.1 FM模块(M1)与主板的连接电路

FM模块（图中的M1）通过J3与平台主板相连接，其中，J3的3、4脚是I2C通信接口。芯片地址C0，I2C通信时，取芯片地址的高7位（0x60）。TEA5767数据传输直接向芯片顺序发送1个地址跟5个数据，不需要知道每一个寄存器的地址。




IIC编程接口

驱动实现采用IIC设备驱动的方式，同三轴加速度。我们可以通过open函数打开IIC的设备文件，通过ioctl函数设定要访问从设备的地址，然后就可以通过read和write或者ioctl函数完成对IIC设备的读写操作。


	打开适配器对应的设备节点
如果使用read()跟write(),必须提前设置从机地址，运用
ioctl(fd, I2C_SLAVE,addr)；此次实验没有用到read()跟write()，所以不用设置：




        fd = open(I2C_DEV, O_RDWR);
        if(fd < 0)
        {
            printf("####i2c test device open failed####\n");
            return (-1);
        }   
        res = ioctl(fd,I2C_TENBIT,0);   //在读写时，取地址的高七位
        if(res<0)
        {
            printf("ioctl:%s\n",strerror(errno));
            return;
        }
        ioctl(fd,I2C_TIMEOUT,1);/*超时时间*/
        ioctl(fd,I2C_RETRIES,2);/* 收不到ACK时重复次数*/






	向FM写数据




void write_FM(int fd)
{
             /***write data to tea5767**/
                 tea_data.nmsgs=1;
                 (tea_data.msgs[0]).flags=0; //write

                 int ret = ioctl(fd,I2C_RDWR,(unsigned long)&tea_data);
                 if(ret<0)
                 {
                    printf("ioctl write data:%s\n",strerror(errno));
                    return ;
                 }
                bzero((tea_data.msgs[0]).buf,5*sizeof(char));//每次写完清空数据，防止污染读取的数据
                usleep(10);
}






	从FM读数据
读数据时，至少在写入数据40ms之后再读取，不然数据不稳定




void read_FM(int fd)
{
/******read data from tea*******/
tea_data.nmsgs=1;
(tea_data.msgs[0]).len=0;//每次传送要5个字节
(tea_data.msgs[0]).addr=0x60;// tea5767地址
(tea_data.msgs[0]).flags=0;//write
(tea_data.msgs[0]).buf[0]=0xc1; 
write_FM(fd);//先写入要读取的地址
tea_data.nmsgs=1;
(tea_data.msgs[0]).len=5;//每次传送要5个字节
(tea_data.msgs[0]).addr=0x60;// tea5767地址
(tea_data.msgs[0]).flags=I2C_M_RD;//read
(tea_data.msgs[0]).buf[0]=0; 
(tea_data.msgs[0]).buf[1]=0; 
(tea_data.msgs[0]).buf[2]=0; 
(tea_data.msgs[0]).buf[3]=0; 
(tea_data.msgs[0]).buf[4]=0; 
int ret = ioctl(fd,I2C_RDWR,(unsigned long)&tea_data);
if(ret<0)
{
   printf("ioctl read data:%s\n",strerror(errno));
     return ;
    }
unsigned int pll_h,pll_l;
pll_h=(tea_data.msgs[0]).buf[0];
pll_l=(tea_data.msgs[0]).buf[1];
pll_h &= 0x3f;
pll = (pll_h*256)|pll_l;
get_frequency();
} 






	读写数据结构体




tea_data.nmsgs=1;//消息的数量
(tea_data.msgs[0]).len=5;//每次传送要5个字节
(tea_data.msgs[0]).addr=0x60;// tea5767地址 高七位
(tea_data.msgs[0]).flags=I2C_M_RD;//read 。//0是write，
(tea_data.msgs[0]).buf[0]=0; //5个数据
(tea_data.msgs[0]).buf[1]=0; 
(tea_data.msgs[0]).buf[2]=0; 
(tea_data.msgs[0]).buf[3]=0;
(tea_data.msgs[0]).buf[4]=0;






	自动搜台




void auto_search(int fd)
{
    printf("\nsearching....\n");
    frequency=max_freq;
    bzero(freq_array,80*sizeof(char));
    count=0;
    while(1)
    {
        while(((tea_data.msgs[0]).buf[0])<0x30)//信号强度，可调节
        {
            get_pll();
            bzero((tea_data.msgs[0]).buf,5*sizeof(char))
            (tea_data.msgs[0]).buf[2]=0x20;//the data to write
            (tea_data.msgs[0]).buf[0]=(pll/256) ;
            (tea_data.msgs[0]).buf[0] |= 0x40;// 
            (tea_data.msgs[0]).buf[1]=pll%256;//the data to write   
tea_data.msgs[0]).buf[3]=0x11;//the data to write       
(tea_data.msgs[0]).buf[4]=0x00;//the data to write
write_FM(fd);
bzero((tea_data.msgs[0]).buf,5*sizeof(char));
read_FM(fd)；
}
if(frequency>min_freq)
{       
freq_array[count]=frequency;    
count++;
}else
    ;
usleep(100);
bzero((tea_data.msgs[0]).buf,5*sizeof(char));
frequency-=100; 
if(frequency<min_freq)
{
printf("END search .all %d channel.\n",count);
printf("Input the 1~%d to choose the channel to listen\n",count);
into_clience(fd);
        return;
    }
}
}










实验步骤

说明：将FM模块插入到EXPORT扩展接口上。模块上的J1两个引脚为天线接头，可插上杜邦线提高信号质量。


导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_11_FM。







演示运行


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	界面启动后会自动搜台，之后点击下方的按键即可收听指定频段的电台节目。如图5.2.1所示：




[image: ../../_images/ch05_11_ui.png]FM

图5.2.1 FM收音机









          

      

      

    

  

  
    
    实验十二. 基于MCP2510的CAN总线开发实验
    

    
 
  

    
      
          
            
  
实验十二. 基于MCP2510的CAN总线开发实验




实验目的


	掌握CAN总线通讯原理;


	学习CAN字符驱动接口，编写NDK程序实现控制;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机,mini USB数据线;


	软件： Android Studio 2.2 或更高版本， Android Plugin for Gradle 版本 2.2.0 或更高版本，CMake;







实验内容


	学习CAN字符驱动接口，使用Android Stuido创建JNI项目操作该设备来控制CAN总线实现通讯。







实验原理

CAN总线控制器MCP2510硬件原理及使用SPI子系统注册MCP2510 CAN总线驱动具体流程请参阅Linux光盘中CAN总线实验章节。

系统运行后会产生dev/can0设备，上层编写JNI程序对其进行操作实现读写等功能。


驱动接口函数

在can.h头文件中定义操作CAN总线的宏定义及结构体，具体如下：

#ifndef CAN_H__
#define CAN_H__

#include <linux/types.h>

#define CAN_IOCTRL_SETBAND            0x1    //设置波特率
#define CAN_IOCTRL_SETID              0x5    //设置帧ID
#define CAN_IOCTRL_SETLPBK            0x3    //设置模式（回环/正常）
#define CAN_IOCTRL_SETFILTER          0x4    //为CAN设备设置过滤器
#define CAN_IOCTRL_PRINTRIGISTER    0x2    // 打印spi和portE的寄存器信息

#define CAN_EXCAN                    (1<<31)    //extern can flag
typedef enum {
    BandRate_125kbps = 1,
    BandRate_250kbps = 2,
    BandRate_500kbps = 3,
    BandRate_1Mbps = 4
} CanBandRate;

typedef struct {
    unsigned int id;          //CAN总线ID
    unsigned char data[8];    //CAN总线数据
    unsigned char dlc;        //数据长度
    int IsExt;    //是否是扩展总线
    int rxRTR;    //是否是远程帧
} CanData, *PCanData;

/*********************************************************************\
    CAN设备设置接收过滤器结构体
    参数: IdMask，Mask
            IdFilter，Filter
    是否接收数据按照如下规律:
    Mask    Filter  RevID   Receive
    0       x       x       yes
    1       0       0       yes
    1       0       1       no
    1       1       0       no
    1       1       1       yes
    
\*********************************************************************/
typedef struct {
    unsigned int Mask;
    unsigned int Filter;
    int IsExt;    //是否是扩展ID
} CanFilter, *PCanFilter;

#endif






	打开设备




 fd = open("dev/can0", O_RDWR);






	关闭设备




 close(fd);






	初始化CAN设备




  ioctl(fd, CAN_IOCTRL_PRINTRIGISTER, 1);
        ioctl(fd, CAN_IOCTRL_SETID, id);
        if (isLoop) { //是否回环标志位
            ioctl(fd, CAN_IOCTRL_SETLPBK, 1);
        }






	读取数据




 char temp[16]; //保存CAN数据帧中的数据位数据
    bzero(temp, 16);
    int k = 0;
    CanData data = {0};
    if (fd == -1) {
        LOGE("Can is not open!", "");
        data.id = 0;
        data.dlc = 0;
    } else {
        read(fd, &data, sizeof(CanData));
        for (k = 0; k < data.dlc; k++)
            temp[k] = data.data[k];
        temp[k] = 0;
        sleep(delaytime);
    }






	写数据




static void CanSendString(char *pstr) {
    CanData data;
    int len = strlen(pstr);
    memset(&data, 0, sizeof(CanData));
    data.id = 0x123;
    data.dlc = 8;
    for (; len > MAX_CANDATALEN; len -= MAX_CANDATALEN) {
        memcpy(data.data, pstr, 8);
        write(fd, &data, sizeof(data));
        pstr += 8;
    }
    memset(&data, 0, sizeof(CanData));
    data.id = 0x123;
    data.dlc = len;
    memcpy(data.data, pstr, len);
    write(fd, &data, sizeof(data));
}










实验步骤


导入工程源码


	打开Android Studio，从菜单栏选择 File > Open。


	弹窗中浏览选择光盘src目录下的Gradle工程 CH05_NDK ,点击OK导入。


	等待工程构建完成后，在工具栏中的Android App列表中选择本实验例程CH05_12_CAN。







演示运行


	平台主板通过miniUSB线连接电脑后，点击 Run
[image: ../../_images/toolbar-run1.png]从菜单栏运行应用
运行程序。


	进入界面后若单个平台测试时需勾选[x]回环显示选项。


	点击右侧的打开按钮打开CAN设备。弹窗提示请求获取权限，点击授权允许。
若打开成功下方的清空和发送按钮才可以使能。


	在左侧文本框中输入相应英文字符，点击下方发送按钮。发送成功会在右侧接收区显示，如图5.2.1所示：




[image: ../../_images/ch05_12_ui.png]CAN

图5.2.1 CAN测试程序
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第五章.  Android系统架构实验
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实验一. Android Ubuntu编译环境搭建




实验目的


	掌握Ubuntu 12.04 操作系统的安装;


	掌握交叉编译器的安装;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机;


	软件：VMware;







实验内容


	虚拟机上安装Ubuntu 12.04操作系统;


	建立Android系统开发环境，安装Android配套的交叉编译器;







实验步骤


系统镜像下载

Ubuntu12.04 LTS官网下载地址：http://www.ubuntu.org.cn/download/desktop

选择64位版本下载（Android光盘\src\chapter05\experiment01目录已经提供，建议用户使用的软硬件环境与本书保持一致，实际硬件差异需要具体灵活设置和下载相应的资源包）。




在VMware中安装Ubuntu系统


	打开VMware，点击File菜单选择New Virtual Machine。在弹出的窗口选择Typical 典型安装，点击下一步，如图4.2.1所示




[image: ../../_images/4.2.1.png]

图4.2.1


	选择ISO镜像的目录，点击下一步，如图4.2.2所示




[image: ../../_images/4.2.2.png]

图4.2.2


	输入Full name,user name,password ,点击下一步，如图4.2.3所示




[image: ../../_images/4.2.3.png]

图4.2.3


	点击Browse选择安装路径，点击下一步，如图4.2.4所示




[image: ../../_images/4.2.4.png]

图4.2.4


	Ubuntu需要硬盘空间大约5G，Android源码编译后占硬盘空间大约29G , linux内核编译后约1.9G，因此建议提前为Ubuntu12.04 的安装预留大约40G的空间，点击下一步，如图4.2.5所示




[image: ../../_images/4.2.5.png]

图4.2.5


	点击Customize Hardware , 做一些启动基本配置，如图4.2.6和图4.2.7所示




[image: ../../_images/4.2.6.png]

图4.2.6

（注意： 推荐内存大于1G，否则因为内存大小限制将无法编译Android文件系统）

[image: ../../_images/4.2.7.png]

图4.2.7


	点击finish开始安装，如图4.2.8所示




[image: ../../_images/4.2.8.png]

图4.2.8


	Ubuntu12.04使用Easy Install工具自动连接互联网安装部分资源包和软件，需一定安装时间。可点击skip跳过，进入系统之后再另外更新安装。如图4.2.9所示




[image: ../../_images/4.2.9.png]

图4.2.9


	安装完成之后虚拟机会自动重启，进入VMware Easy Install命令行登录界面，如图4.2.10所示




[image: ../../_images/4.2.10.png]

图4.2.10


	点击VMware中的Power Off按键强制关闭AndroidDev虚拟机，如图4.2.11所示




[image: ../../_images/4.2.11.png]

图4.2.11


	点击Edit virtual machine settings，在弹出来的设置窗口中remove掉CD/DVD（IDE）设备。把Floppy中的Connection方式选择为Use physical drive：-> Auto detect。之后点击Power on启动虚拟机。如图4.2.12所示




[image: ../../_images/4.2.12.png]

图4.2.12


	在[ubuntu login:]处输入用户名cbt，回车后输入之前步骤中设置的密码进行登录。在cbt@ubuntu:~$后输入startx命令进入系统图像界面，如图4.2.13所示




[image: ../../_images/4.2.13.png]

图4.2.13


	进入系统后，点击VMware菜单中的VM -> Install VMware Tools选项。弹出对话框选择yes，如图4.2.14所示




[image: ../../_images/4.2.14.png]

图4.2.14


	点击右上角的图标选择Log out 退出系统，如图4.2.15所示




[image: ../../_images/4.2.15.png]

图4.2.15


	执行如下命令:




$ sudo mv /etc/issue.backup /etc/issue
$ sudo mv /etc/rc.local.backup /etc/rc.local
$ sudo mv /opt/vmware-tools-installer/lightdm.conf /etc/init





之后再执行sudo reboot 命令重启或者执行sudo start lightdm命令便可以进入图形登录界面。如图4.2.16所示

[image: ../../_images/4.2.16.png]

图4.2.16


	进入系统后，按照下面提示继续安装VMware Tools工具。打开Terminal终端，进入VMware Tools光盘目录将其解压到本地目录/tmp下。命令如下：




$ cd /media/VMware Tools
$ tar xvf VMwareTools-8.8.0*.tar.gz -C /tmp
$ cd /tmp/VMware-tools-distrib/





执行：

$sudo ./VMware-install.pl 






	接下来的安装步骤中，一直按回车键确认安装即可。此步骤可能需要一定时间，如图4.2.17所示




[image: ../../_images/4.2.17.png]

图4.2.17


	在Terminal命令行终端中中连接互联网更新之前skip过的内容，执行如下命令：




$ sudo apt-get upgrade
$ sudo apt-get update






	安装vim编辑器：




$ sudo apt-get install vim-gtk








安装Android 配套的交叉编译器


	打开Terminal，输入cp 之后把Android光盘\src\chapter05\experiment01中的arm-linux-gcc-4.5.1.tar.gz压缩包拖拽拷贝到 ~/目录下，如图4.3.1所示




[image: ../../_images/4.3.1.png]

图4.3.1


	执行解压命令




$ tar  xvf  arm-linux-gcc-4.5.1.tar.gz 





执行该命令，将把arm-linux-gcc 安装到~/toolschain/4.5.1目录下。


	把编译器的路径加入到系统环境变量，运行命令




$ sudo gedit ~/.bashrc 





编辑~/.bashrc文件，修改最后一行为

export PATH=$PATH:~/toolschain/4.5.1/bin





注意路径一定要依据上面解压步骤更改正确，否则将不会有效，如图4.3.2所示，保存退出。

[image: ../../_images/4.3.2.png]

图4.3.2


	执行命令：




 source ~/.bashrc






	在命令行输入arm-linux-gcc -v，出现如下打印信息，则说明交叉编译环境已经成功搭建。




gcc version 4.5.1 (ctng-1.8.1-FA) 





注：若由于切换root用户无法在终端中输入或找到arm-linux-gcc命令，可手动执行
source ~/.bashrc命令导入环境变量，之后即可输入上述命令查看。









          

      

      

    

  

  
    
    实验二. Android 内核移植与编译实验
    

    
 
  

    
      
          
            
  
实验二. Android 内核移植与编译实验




实验目的


	掌握Android 内核裁减与定制的基本方法;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机;


	软件：VMware Workstation + Ubuntu 12.04 + ARM-LINUX 交叉编译开发环境;







实验内容


	学习Android 内核裁减定制的基本配置方法，利用Android 设备配套Android 内核进行自定义功能（如 helloword 显示）的添加。并重新编译内核源码，生成内核压缩文件uImage ，下载到Android 设备中测试;







实验步骤


复制内核源码至实验目录


	将Android光盘\src\chapter04\experiment01下的内核源码包“linux-3.5.tar.gz”复制到Ubuntu 12.04 相应目录下并解压




$ sudo -s        //输入普通用户密码切换到超级用户
#tar xvf linux-3.5.tar.gz
#cd linux-3.5/  








编译内核

在宿主机端为Android 平台设备 linux-3.5内核编写简单的测试驱动（内核）程序helloworld.c，并修改内核目录中相关文件，添加对测试驱动程序的支持。


	使用vim 编译器手动编写实验代码helloworld.c（Android光盘\src\chapter05\experiment02已经存在，可以参考）




# vim helloworld.c





helloworld.c 内容如下：

#include<linux/init.h>
#include<linux/module.h>
// 驱动程序的入口函数
static int hello_init(void)
{
printk(KERN_ALERT”#########Hello, workd !  Cyb-Bot ##############\n”);
return 0;
}
//驱动程序的出口函数
static void hello_exit(void)
{
printk(KERN_ALERT”#############Goodbye , world ########\n”);
}
module_init(hello_init);
module_exit(hello_exit);
MODULE_LICENSE(“Dual  BSD/GPL”);





有关驱动程序的编写规范，请参考后续驱动实验内容，本实验只在编写简单的驱动（内核）程序并加入到Linux 内核目录树中，使用户熟悉编译内核的过程。该驱动程序是向终端输出相关程序信息。
编写好helloworld.c 后将其拷贝到内核源码的drivers/char/目录下。

#cp  helloworld.c  linux-3.5/drivers/char/






	进入实验内核源码目录修改drivers/char目录下的Kconfig 文件，按照Kconfig 语法添加helloworld程序的菜单支持




#cd  linux-3.5/drivers/char/
#vim  Kconfig





在Kconfig文件中添加如下代码：

config  HELLO_WORLD     //驱动名称
      bool “Hello  World  Test” //内核编译是bool类型
      depends  on  ARCH_EXYNOS4  //HELLO_WORLD只有ARCH_EXYNOS4板子上有效
      default  y        //y表示默认运行
      help          //提示说明，无实际意义  
          This is a demo to test kernel experiment On  Android .





注意config HELLO_MODULE 段要与前后段有空格隔开，且bool、tristate等变量要与行开头有TAB符号位隔开。注意Konfig 的格式（用户可以拷贝原有内容进行修改）。


	进入实验内核源码目录修改driver/char/目录下的Makefile 文件，按照内核中Makefile语法添加helloworld程序的编译支持




#vim  Makefile





在Makefile 中添加下面一行：

obj-$(CONFIG_HELLO_WORLD)     += helloworld.o






	在内核源码目录运行make menuconfig 配置内核对helloword程序的支持


	执行make menuconfig（注：执行之前确保开发环境当中有ncurses库，执行sudo apt-get insatll ncurses-dev下载）


	配置helloword,静态编译。





│     -> Device Drivers                                                                             │
│       -> Character devices
│             -> Hello World Test





	退出保存内核配置。


	在内核源码的顶层目录下编译内核




#   make        
  HOSTLD  scripts/kconfig/conf
scripts/kconfig/conf -s arch/arm/Kconfig
*
* Restart config...
*
*
* Character devices
*
Virtual terminal (VT) [Y/n/?] y
  Enable character translations in console (CONSOLE_TRANSLATIONS) [Y/n/?] y
  Support for console on virtual terminal (VT_CONSOLE) [Y/n/?] y
  Support for binding and unbinding console drivers (VT_HW_CONSOLE_BINDING) [N/y/?] n
Memory device driver (DEVMEM) [Y/n/?] y
/dev/kmem virtual device support (DEVKMEM) [Y/n/?] y
Hello World Test (HELLO_WORLD) [Y/n/?] (NEW)     //输入“y”





初次编译内核源码，由于内核源码代码庞大，所需较长时间。编译成功后会在内核源码目录的arch/arm/boot/目录下生成内核压缩文件zImage。


	按照Android光盘配套烧写文档将新生成的内核镜像文件zImage 烧写到Android平台设备中（Android系统如何安装详见Android光盘\IMG\Cortex-A9系统烧写说明.pdf）




新内核烧写成功后启动Android 实验平台，可以在串口终端中查看到Linux内核在加载过程中打印出来的信息，如图5.2.1所示（内核加载只需要2-3秒，为了方便观察现象，可以在内核加载2-3秒后关闭电源来查看打印出来的信息）

#########Hello , world ! Cyb-Bot !###########
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实验三. 基于IIC总线的EEPROM驱动移植实验




实验目的


	熟悉平台主板外围设备EEPROM芯片AT24CXX的电路结构与工作原理;


	掌握IIC总线设备驱动移植流程;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机;


	软件：VMware,Linux OS;







实验内容


	移植IIC总线EEPROM设备驱动;







实验原理


	AT24CXX芯片简介





AT24CXX是美国ATMEL公司的低功耗CMOS串行EEPROM，典型的型号有AT24C01A/02/04/08/16等5种，它们的存储容量分别是1024/2048/4096/8192/16384位；也就是128/256/512/1024/2048字节；使用电压级别有5V，2.7V,2.5V,1.8V。





	平台主板外设原理图




[image: ../../_images/AT24.png]

AT24CXX的1、2、3脚是三条地址线，用于确定芯片的硬件地址（因为只有一块器件平台主板中直接接地）;第8脚和第4脚分别为正、负电源。第5脚SDA为串行数据输入/输出，数据通过这条双向I2C总线串行传送，SDA和SCL都需要和正电源间各接一个5.1K的电阻上拉。第7脚为WP写保护端，接地时允许芯片执行一般的读写操作。接电源端时不允许对器件写。

AT24CXX中带有片内地址寄存器。每写入或读出一个数据字节后，该地址寄存器自动加1，以实现对下一个存储单元的读写。所有字节均以单一操作方式读取。为降低总的写入时间，一次操作可写入多达8个字节的数据。

AT24CXX用户手册




5. 实验步骤


配置内核


	打开I2C支持




Location:


│     -> Device Drivers                                                                             │

│       -> I2C support (I2C [=y])





	打开杂项设备，该选项打开后，EEPROM也就打开了。




Location:


│     -> Device Drivers                                                                             │

│       -> Misc devices                                                                             │

│         -> EEPROM support




行内代码块 code




修改代码,在内核板级支持包中增加AT24CXX设备配置

linux-3.5内核中已经包含at24cxx芯片的驱动源码，具体位置为：


_include/linux/i2c/at24.h _

_/drivers/misc/eeprom/at24.c_




修改板级支持包文件: arch/arm/mach-exynos/mach-tiny.c

增加如下代码:

#ifdef CONFIG_EEPROM_AT24
#include <linux/i2c/at24.h>
static struct at24_platform_data at24c02 = {
    .byte_len = SZ_2K / 8,
    .page_size = 8,
    .flags = 0,
};
#endif
static struct i2c_board_info smdk4x12_i2c_devs0[] __initdata = {
#ifdef CONFIG_EEPROM_AT24
    {
        I2C_BOARD_INFO("24c02", 0x50),
        .platform_data = &at24c02,
    },
#endif
};





代码说明：AT24CXX使用8位地址，内存大小2K比特位，也就是256K字节，页大小为8字节。

手册中AT24CXX的设备地址是

| 1 | 0 | 1 | 0 | A2 | A1 | A0 | R/W |
| :—: | :—: | :—: | :—: | :—: | :—: | :—: | :—: |

其最低位是读写标志位，但是在Linux中，I2C设备地址的最高位为0，而低七位地址就是手册中去掉R/W的剩余7位。在实验原理中可知A2 A1 A0引脚接GND，因此，地址为0b 01010000（0x50）。




编译并烧写内核

按照Android光盘配套烧写文档将新生成的内核镜像文件zImage 烧写到Android平台设备中（Android系统如何安装详见Android光盘\IMG\Cortex-A9系统烧写说明.pdf）




在终端中查看eeprom设备

新内核烧写成功后启动Android 实验平台，可以在串口终端中查看生成的eeprom设备。

root@android:cd /sys/bus/platform/devices/s3c2440-i2c.0/i2c-0/0-0050
root@android:/sys/bus/platform/devices/s3c2440-i2c.0/i2c-0/0-0050 # ls
driver
eeprom
modalias
name
power
subsystem
uevent
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实验四. 基于GPIO方式的红外驱动移植实验
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实验五. 4G模块ZTE ME3760驱动移植实验
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实验六. Android 文件系统编译实验




实验目的


	掌握Android 文件系统的搭建过程;


	熟悉Android 文件系统的初始化脚步及启动过程;







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机;


	软件：VMware Workstation + Ubuntu 12.04 + JDK编译环境;







实验内容


	安装编译环境：JDK及需要的开发包;


	编译Android文件系统源代码;


	制作根文件系统的镜像







实验步骤


安装编译环境

将Android光盘\src\chapter05\experiment06下的“ubuntu”文件夹拷贝到“/tmp”目录下


安装JDK

启动Ubuntu系统后，按下ctrl+alt+t打开一个终端。
输入命令

sudo apt-get install openjdk-7-jdk





输入密码后安装。


	配置环境变量




执行sudo gedit /etc/profile 文件末尾添加：

JAVA_HOME=/usr/lib/jvm/java-7-openjdk-amd64/
PATH=$PATH:$HOME/bin:$JAVA_HOME/bin
export JAVA_HOME
export PATH





执行如下命令刷新环境变量：

sudo source /etc/profile





验证java是否配置完成，可以在终端输入java --version，如果能够正确的打印出java版本就表示成功。




安装编译源码所需要的工具集

Android文件系统的编译需要安装一些开发包，确保虚拟机已经联网，在终端执行install-devel-packages.sh脚本：

# cd /tmp/ubuntu/
# chmod 755 install-devel-packages.sh
# ./install-devel-packages.sh





中途会询问是否下载软件包，输入Y回车即可。






编译Android 文件系统源码

注：要求最低内存1.5G左右，硬盘40G以上。


	将Android光盘\src\chapter05\experiment06下android文件系统源码包“android-4.2.2_r1.tar.gz”复制到Ubuntu 12.04 的目标目录下（例如本次实验虚拟机目标目录为/home/cbt/Android），然后解压：




$ suod -s 
//输入密码后切换成root权限
# tar jxvf android-4.2.2_r1.tar.gz
//然后进到目录android-4.2.2_r1下
# cd android-4.2.2_r1






	设置相关编译环境变量，执行：




#  .  setenv ;“.”后面有一空格






	开始编译




#make -j3





注：若出现如下错误提示：

build/core/config.mk:268: *** Error: could not find jdk tools.jar, please install JDK6, which you can download from java.sun.com。 停止。





可执行如下命令，将JDK导入到环境变量中：

# source /etc/environment





编译源代码需要等待很长的时间，请耐心等待。编译完成后系统会自动生成相关的文件系统镜像：.
out/target/product/tiny4412/可在这里找到各个部分，如图4.3.1所示：

[image: ../../_images/4.3.11.png]

图4.3.1




制作文件系统镜像


	运行gen-img.sh脚本，从编译完成的Android文件系统源码中提取我们需要的目标文件系统，最后生成img镜像,如图4.4.1所示：




#. gen-img.sh   // . 后面有空格，提取并生成目标文件系统镜像





[image: ../../_images/4.4.1.png]

图4.4.1


	将本章实验二中生成的zImage和本实验生成的各个img镜像烧写到Android平台上（Android系统如何安装详见Android光盘\IMG\Cortex-A9系统烧写说明.pdf），开发板上电，如图4.4.2所示




[image: ../../_images/4.4.2.png]

图4.4.2
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实验一. 北斗/GPS模块实验




实验目的


	学习北斗GPS定位技术，掌握GPS协议标准;


	掌握Android串口数据解析的方法;


	掌握Handler的使用机制，实现子线程与UI线程的通信







实验环境


	硬件：CBT-EMB-MIP 实验平台,PC机，北斗GPS双核模块;


	软件：Android Studio;







实验内容


	分析北斗GPS输出数据协议帧各数据位含义;


	编写Android程序解析GPS数据;







实验原理


GPS简介

GPS(Global Positioning System), 即全球定位系统，它是一个由覆盖全球的24颗卫星组成的卫星系统。其目的是在全球范围内对地面和空中目标进行准确定位和监测。随着全球性空间定位信息应用的日益广泛，GPS提供的全时域、全天候、高精度定位服务将给空间技术、地球物理、大地测绘、遥感技术、交通调度、军事作战以及人们的日常生活带来巨大的变化和深远的影响。

GPS系统一般由地面控制站、导航卫星和用户接收机（GPS的移动用户端）三大部分组成。导航卫星至少24颗，均匀分布在6个极地轨道上，轨道的夹角为60度，距地平均高度为20200公里，每12恒星时绕地球一周。




北斗GPS标准NEMA数据格式协议介绍

[image: ../../_images/4.2.png]

北斗双核模块NEMA协议输出信息主要包括以下几个部分：

 
  	模式
  	语句名称
  	功能
   

 

    	GPS模式


   	GPGGA
    	坐标位置数据



   	GPRMC
    	运输定位数据



   	GPGSA
    	DOP与有效卫星



   	GPGSV
    	GPS卫星状态信息


    	BD模式


   	BDGGA
    	坐标位置数据



   	BDRMC
    	运输定位数据



   	BDGSA
    	DOP与有效卫星



   	BDGSV
    	BD卫星状态信息


    	GPS
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实验二. 4G模块拨号上网实验
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实验二. GPRS模块实验
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实验三. 基于14443高频模块的电子钱包实验
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实验四. 4G模块拨号上网实验
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实验四. 基于WSN模块的组网通讯实验
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实验五. 基于WSN模块的组网通讯实验
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[ .bashrc %

# Add an "alert” alias for long running commands. Use Like so

# sleep 10; alert

alias alert='notify-send --urgency=low -i "$([ $? = @ ] && echo
terminal || echo error)” "$(history|tail -ni|sed -e '\''s/~\s*[0-9]\+
\s*//;s/[;&|\s*alerts//"\'")""

# Alias definitions.
# You may want to put all your additions into a separate file Llike
# ~/.bash_aliases, instead of adding them here directly.

# See Jusr/share/doc/bash-doc/examples in the bash-doc package.

if [ - ~/.bash_aliases 1; then
. ~/.bash_aliases
i

# enable programmable completion features (you don't need to enable
# this, if it's already enabled in /etc/bash.bashrc and /etc/profile
# sources /etc/bash.bashrc).
if [ - /etc/bash_completion ] && ! shopt -oq posix; then

. Jetc/bash_completion
i
export PATH=SPATH:~/toolschain/4.5.1/bin

Plain Text ~ Tab Width: 8 ~ Ln1, Col1
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